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1

Chapter

1

Building Information Modeling
 
  

Building information modeling (BIM) is an integrated workflow built on coordinated, reliable
information about a project from design through construction and into operations. The Revit®
platform is purpose-built software for building information modeling.

  
Building information modeling (BIM) makes sustainable design practices easier by enabling architects
and engineers to more accurately visualize, simulate, and analyze building performance earlier in the
design process. Revit Architecture is interoperable with Autodesk Ecotect™ Analysis.

 
Chapter Objective

  
After completing this chapter, you will be able to describe building information modeling methodology.

■ Describe building information modeling methodology.
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2          ■         Chapter 1: Building Information Modeling

Lesson: Building Information Modeling for
Lesson: Architectural Design
 

  
This lesson describes building information modeling (BIM) for architectural design.  
Applying building information modeling helps in designing and delivering innovative projects faster
and more economically.

  
BIM enables architects and engineers to use digital design information to visualize, simulate, and
analyze their projects’ real-world appearance, performance, and cost. BIM also enables architects and
engineers to document the design more accurately. The consistent, coordinated information inherent
in the BIM process helps in developing and evaluating multiple alternatives at the same time and
enables easy comparison and better decisions related to sustainable design.  

 
Objectives

  
After completing this lesson, you will be able to:

■ Describe building information modeling.
■ Describe bidirectional associativity.
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About Building Information Modeling
   

Building information modeling is a building design and documentation process. It enables you to
create and manage information about a building project, using the information about the building
project which is stored in a 3D model. More importantly, the intelligent data inherent in the building
model allows you to experience your design before it is real, simulate and visualize design alternatives,
analyze performance, and make better informed design decisions earlier in the process.

  
The building industry has traditionally illustrated building projects with manually created drawings.
Information was added to these drawings by using notes and specifications. With the advent of
CAD technology, this process was made faster and easier; however, the output of manual drafting,
graphics CAD systems, and object-oriented CAD systems remained the same: a graphic abstraction of
an intended building design.

  
The development of the building information modeling methodology has turned this relationship
around. Building information modeling software captures information about a building and then
presents that information as 2D and 3D views, schedules, or in other required formats.

  
Architects and engineers can use digital design information to analyze and understand how
their projects will perform before they are built. Developing and evaluating multiple alternatives
simultaneously enables easy comparison and informs better sustainable design decisions. Building
information modeling is core to Autodesk’s sustainable design approach for building performance
analysis and simulation.

 
Definition of Building Information Modeling

  
Building information modeling is an integrated process for exploring a project’s key physical and
functional characteristics digitally—before it is built. Autodesk® provides a comprehensive portfolio
of BIM solutions, which assist customers in delivering projects faster and more economically, while
minimizing environmental impact.

   
Coordinated, consistent information is used throughout the BIM process to:

 
■ Design innovative projects and conduct analysis from the earliest stages
■ Better visualize and simulate real-world appearance, performance, and cost
■ Document more accurately  
The Autodesk BIM solution is based on coordinated, data-rich models created with Autodesk® Revit®-
based products and AutoCAD® Civil 3D® software. Complementing these core BIM products is a broad
portfolio of applications further delivering on the power of BIM, including AutoCAD® software for
documentation and conceptual 3D design and AutoCAD LT® software for professional drafting.

  
Revit and Building Information Modeling

  
Revit Architecture is purpose-built software for building information modeling.

  
Traditional drafting and CAD software represent the geometry of a design by using stylized symbols
from designated illustrations. Some examples of these illustrations may be a series of plans, elevations,
and sections. These illustrations are essentially independent of one another.

  
Building information modeling software represents the design as a series of intelligent objects and
elements such as walls, windows, and views. These objects and elements have parametric attributes.
The information about these objects and elements is stored in a single building model. You can extract
any number of different views of the data from the model.  

----------------------------------------------------------------------------------------------------------------------------------------
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4          ■         Chapter 1: Building Information Modeling

  
The Revit platform is a building design and documentation system that supports the design,
documentation, and even construction efforts required for a building project. Because of its
parametric change technology, any change you make is automatically coordinated everywhere in your
project, including model views, drawing sheets, schedules, sections, and plans.

 
Building Information Tailored to the User

  
In building information modeling software, the building information is stored in a single building
model instead of in a format predicated on a presentation format, such as a drawing file or a
spreadsheet. The building information model presents information for editing and review in views and
formats that are appropriate for and familiar to the user. Some examples of these formats are a 2D
elevation, a 3D perspective, or a schedule.

  
Architects, for example, work on the information in the building model by using the conventions of
the highly stylized, symbolic, and graphic language of building design. They may enter and review
information in a format similar to architectural drawings, such as plans, sections, and elevations.
Structural engineers work with the same data presented graphically in the form of framing and
bracing diagrams. Therefore, the structural engineers' interface to data or the MEP engineers' is quite
different from the architects' interface to data; however, the data is the same.

----------------------------------------------------------------------------------------------------------------------------------------
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Lesson: Building Information Modeling for Architectural Design         ■        5

 
Managing Change with Building Information Modeling

  
Building information modeling solutions manage iterative changes in a building model throughout the
design, construction, and operation phases. A change to any part of the building model is replicated in
all other associated parts.

  
Maintaining a single, internally consistent representation of the building can improve drawing
coordination and reduce the number of errors in documents. You can invest the time that you would
otherwise spend manually checking and coordinating documents in improving the building designs. As
a result, construction documents can be of better quality and the costs of changes and coordination
can be reduced. Building information modeling tools can enable the design, construction, and
occupancy of the building to proceed with less friction and fewer difficulties than conventional tools.

 
Capturing and Reusing Information

  
Building information modeling solutions capture and preserve information for reuse by third party
industry-specific applications. Data is captured once as close as possible to its point of origin and
stored so that it is available and can be presented whenever required.

  
For example, consider a personal financial management software application that captures
information from your checkbook register as you write checks and make deposits. It stores and
manages that information for a variety of purposes, such as to prepare your income tax return and
to create a statement of your net worth. Building information modeling leverages data in a similar
manner.

 
Characteristics of Revit Architecture for Building Information Modeling

   
Work the way architects and designers think about buildings:

 
■ Enjoy a more intuitive process with software that mirrors the real world.
■ The building information model contains essential information about a project, so as you design,

Revit software automatically creates accurate floor plans, elevations, sections, and 3D views, as
well as area calculations, schedules, and quantity takeoffs.

■ Gain better design insight through in-process visualization and analysis.
   

Capture early design thinking to better support design, documentation, and construction:
 

■ Enhance conceptual building design efforts to gain better design insight earlier in the process.
■ Support smarter, more sustainable design through the analysis of materials, quantities, sun

position, and solar effects. Exchange building information with partner applications to perform
energy analysis and better predict building performance.

■ Provide essential BIM data for use in clash detection, construction analysis, and fabrication.
   

Improve your business through better-coordinated, higher-quality project work:
 

■ Accelerate decision making and shorten production time.
■ Minimize coordination mistakes and rework with fully parametric change management.
■ Gain a competitive advantage with increased client satisfaction and greater profitability through

more efficient project delivery.

----------------------------------------------------------------------------------------------------------------------------------------
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6          ■         Chapter 1: Building Information Modeling

 
Analyzing a Design in the Context of BIM

  
Revit-based design models can be exported using the gbXML schema and imported directly into
Autodesk Ecotect Analysis for simulation and analysis during the early conceptual design phase. At the
onset of the design process, Autodesk Revit Architecture massing models can be used in combination
with site analysis functionality in Autodesk Ecotect Analysis to determine the optimal location, shape,
and orientation of a building design. This is based on fundamental environmental factors, such as
daylight, overshadowing, solar access, and visual impact.

  
As the conceptual design evolves, energy, water, and carbon analysis can be conducted using
integrated access to Autodesk® Green Building Studio® web-based technology in order to benchmark
its energy use and recommend areas of potential savings. After these fundamental design parameters
have been established, Autodesk Ecotect Analysis can be used again to rearrange rooms and zones,
size and shape apertures, design custom shading devices, or choose specific materials—based on
environmental factors such as daylight availability, glare protection, outside views, and acoustic
comfort.

  
Autodesk Ecotect Analysis can also be used for detailed design analysis. For example, the visibility
analysis displayed in the following illustration shows the amount and quality of views to the outside
mapped over the floor area of an office.  

  
The consistent, computable data obtained from Autodesk Revit Architecture or Autodesk Revit MEP,
combined with the breadth of performance analysis and meaningful feedback of Autodesk Ecotect
Analysis, help reduce the cost and time required to perform energy modeling and analysis. The
feedback from these analyses helps architects and other users to optimize the energy efficiency of
their designs and work toward carbon neutrality early in the design process. The analyses are a key
ingredient not only for incorporating energy efficiency into standard building design practices but also
for mitigating the carbon footprint of the current built environment.
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Example of Building Information Modeling

  
During the design of a building, if there is any change in the load conditions on the floor area, you
may need to modify the design parameters of the structural system. Modifications could include an
increase in the depth of beams or a change in beam profiles. A change in beam profiles may result
in a change in the geometric parameters of these members in a 3D view. This change would also be
reflected in plan and section views. Therefore, building information modeling ensures an effective
interaction between the design and its representation.

 

About Bidirectional Associativity
   

A key feature of Revit is bidirectional associativity, which ensures that changes to any part of the
design are immediately reflected in all associated parts.

 
Definition of Bidirectional Associativity

  
Bidirectional associativity is the ability of the building information model to coordinate changes made
in any view and propagate these changes out to all other views. Bidirectional associativity is applied
automatically to every component, view, and annotation. For example, a change in the position of a
wall is reflected in all elements such as windows, doors, ceilings, and electrical outlets; all of which are
associated with the wall and influenced by the change in the location of the wall. These elements are
also affected by the constraints and alignments that have been established for the wall. Revit helps
ensure that building sections and elevations are immediately available, up-to-date, and accurate.  

----------------------------------------------------------------------------------------------------------------------------------------
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8          ■         Chapter 1: Building Information Modeling

 
Parametric Relationships

  
The term parametric refers to the relationships among the elements of a building model. These
relationships enable the software to coordinate and manage the changes made to the building model.
The relationships are created either automatically by the software or by you. In mathematics and
mechanical CAD, the numbers or characteristics that define these relationships are called parameters;
therefore, the operation of the software is called parametric. It is these parametric relationships that
deliver fundamental coordination and productivity benefits provided by the building information
modeling methodology.  

 
Updating the Building Model

  
A fundamental characteristic of building information modeling software is the ability to coordinate
changes and maintain consistency. You do not have to intervene to update drawings or links. When
you change something, the bidirectional associativity feature of the software determines the
elements that are affected by the change and propagates that change to any affected elements.
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Examples of Bidirectional Associativity
■ Flip a section line and all views update.
■ Draw a wall in plan and it appears in all other views including material takeoffs.
■ Change a door or a window type in a schedule and the change propagates throughout the

graphical and nongraphical views.
 

Examples of Parametric Relationships
■ A floor is attached to the enclosing walls. When a wall moves, the floor updates to remain

connected to the walls.
■ A series of equidistant windows have been placed along a wall. When the length of the wall

changes, the windows redistribute to remain equidistant across the length of the wall.
■ A relationship has been established between a column and a HVAC duct system to ensure that

a design requirement or code requirement is maintained. When the column is moved, the duct
system moves with it.

----------------------------------------------------------------------------------------------------------------------------------------
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Chapter

2

Revit Architecture Basics
 
  

Before you begin to use Revit Architecture, you need to become familiar with the interface, the types
of objects you will be using to create your designs, and basic project templates.

 
Chapter Objectives

  
After completing this chapter, you will be able to:

■ Describe the Revit Architecture user interface.
■ Work with different types of Revit elements and families.
■ Start a new project with different templates.

----------------------------------------------------------------------------------------------------------------------------------------

KKMSOFT

Downloaded From : www.EasyEngineering.net

Downloaded From : www.EasyEngineering.net

www.EasyEngineering.net

http://easyengineering.net
http://easyengineering.net


12          ■         Chapter 2: Revit Architecture Basics

Lesson: Exploring the User Interface
 

 

 

This lesson describes how to use the different parts of the Autodesk® Revit® Architecture user
interface. You begin the lesson by learning about the main user interface. Then, you learn about the
ribbon tabs and some recommended practices for using the user interface. The lesson concludes with
an exercise on exploring the user interface.  
Revit Architecture provides a friendly user interface where tools and options are available on the
ribbon. In addition, context menus provide quick access to commonly used tools. The status bar
provides information and tips that assist you while you work. Familiarity with the user interface helps
you work with the software more efficiently.  

 Revit Architecture user interface with a project file open
 
 

Objectives
  

After completing this lesson, you will be able to:

■ Identify the different parts of the Revit Architecture user interface.
■ Describe the Revit Architecture ribbon framework.
■ State the recommended practices for using the user interface.
■ Explore the Revit Architecture user interface.

----------------------------------------------------------------------------------------------------------------------------------------
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The Revit Architecture User Interface
   

Revit Architecture is a powerful application that uses the building information modeling methodology
and runs on the Microsoft Windows operating system. Like most Windows applications, the user
interface of Revit Architecture features a ribbon with tabs and panels, toolbars, and dialog boxes that
you can use to perform various tasks. You use the mouse to select buttons from the panels or toolbars
to perform operations.

 
Recent Files Window

  
Every time you launch Revit Architecture, a startup window named Recent Files is displayed. This
window provides links to recently opened project or family files.  

 Recent Files window
 

----------------------------------------------------------------------------------------------------------------------------------------
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14          ■         Chapter 2: Revit Architecture Basics

 
 

Identifying the Primary User Interface Elements
  

The following illustration shows the ribbon in Revit® with different tabs, panels, and buttons. 

  

 

  Application Button   Opens the application menu that provides access to common tools, such as
Save, Print, and Publish.

 

  Tab   Contains tools, settings, and standard functions. Only one tab can be active
at a time and the active tab is on top.

 

  Panel   Groups buttons for similar functions and tools.

 

  Expanded Panel   Expands a panel to display available actions and is indicated by an arrow
next to the panel name. You can temporarily pin an open expanded panel.

 

  Dialog Launcher   Opens a dialog box.

 

  Button   Starts a tool or operation.

 

  Split Button   Opens a drop-down with actions for the particular tool.
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The following illustration shows the Project Browser, status bar, View Control Bar, and other elements
of the Revit Architecture user interface. 

  

 

  Project Browser   Displays a tree view of a logical hierarchy for all views, schedules, sheets, and
families in the current project.

 

  Status Bar   Displays the name of the family and element type when you position the
cursor over an object. Displays tips or hints when you use a comment.

 

  View Control Bar   Provides shortcuts to commonly used view commands, such as View Scale
and Model Graphics Style.

 

  View Window   Displays the view that you have selected in the Project Browser. Views can be
tiled or maximized to fill the entire view window.

 

  Navigation Bar   Displays Zoom controls and opens the Steering Wheels.

 

  View Cube   Works as an orientation control for 3D views.
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16          ■         Chapter 2: Revit Architecture Basics

 
Application Menu

  
The application menu provides access to many common file actions. You can also access advanced
options, such as Export and Publish, to manage files.  

 Application menu
 
 

Quick Access Toolbar
  

The Quick Access toolbar displays the commonly-used actions, such as undo and redo changes, which
you can use on files. You can customize the default Quick Access toolbar by adding tools from the
ribbon.  

 Quick Access toolbar
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InfoCenter Toolbar

  
You use the InfoCenter toolbar to search for information through keywords and access subscription
services and product-related updates. You can also access topics in Help.  

 InfoCenter toolbar
 
 

Context Menus
  

Context menus are displayed when you right-click an object or an area of the user interface. They list
common options, such as Zoom, and other options related to the current task. For example, if you
place a door in a drawing, select it, and then right-click it, the context menu displays options such as
Flip Hand or Flip Facing.

 

The Ribbon Framework
   

The ribbon is displayed at the top of the application window. You use the ribbon to access tools and
options that help you design a building project.

  
You can customize the ribbon by changing its view state and by rearranging the panels that contain the
tools. You can toggle between the ribbon view states by using the control to the right of the Manage
tab.   
The following illustrations show the various ribbon view states. 

 Full ribbon
   

 Ribbon minimized to tab and panel labels
   

 Ribbon minimized to tab labels
 

----------------------------------------------------------------------------------------------------------------------------------------

KKMSOFT

Downloaded From : www.EasyEngineering.net

Downloaded From : www.EasyEngineering.net

www.EasyEngineering.net

http://easyengineering.net
http://easyengineering.net
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Ribbon Tabs

  
The ribbon displays eight tabs and all tools in Revit are available on these tabs. You make a tab active
by clicking its name. Each tab consists of panels of grouped tools.   
The following illustration shows the various ribbon tabs. 

    
The following table lists the tools and options that you can access on the eight ribbon tabs in Revit
Architecture.

 
  
Tab

  
Tools and Options

  Home   Includes commonly used tools for placing building elements such as wall,
door, window, stair, ramp, beam, and brace. This tab also includes tools
grouped by Room and Area, Datum, Work Plane, and Model.

  Insert   Includes tools for linking and importing files, loading family files, and
seeking content online.

  Annotate   Includes tools for placing dimensions, detailing, drafting, text, tags, and
keynotes.

  Modify   Includes tools for editing objects, geometry, linework, and faces. This tab
also includes copy and paste tools using the clipboard, inquiry tools, and
phasing tools.

  Massing & Site   Includes tools for creating conceptual massing studies and creating and
modifying landforms.

  Collaborate   Includes tools for collaboration with internal and external team members.
This tab also includes tools for workset creation, workset management,
and coordination.

  View   Includes tools for controlling graphic appearance of objects, creating
views, and adding sheets. This tab also includes options for toggling
between views and displaying user interface toolbars.

  Manage   Includes tools grouped by Project Settings, Project Location, and Macros.
This tab also includes options for managing projects and design.
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Contextual Tabs

  
When you start a tool or select elements, a contextual tab opens on the ribbon displaying a set of tools
that relate only to the context of that tool or element.

  
The Type Selector drop-down and the Element Properties drop-down are available on the contextual
tabs. Additional tools are also displayed on the contextual tab for working with the element that you
are placing or modifying. The Options Bar appears under the contextual tab.   
The following illustration shows the Place Wall contextual tab that opens when you activate the Wall
tool. 

  

 

  Element Properties
drop-down

  Provides the options to open either the Instance Properties or the Type
Properties dialog box. Using these dialog boxes, you can change the
properties of either an individual instance of a family type or all the instances
of a family type.

 

  Type Selector drop-
down

  Allows you to change from one type of element to another. The contents of
the drop-down change depending on the current tool or selected elements.

 

  Options Bar   Displays options for configuring elements you create or modify. The options
change depending on the current tool or selected elements.
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Guidelines for Using the User Interface
   

User interface elements such as the ribbon, Options Bar, and Project Browser help you to work
efficiently. The following guidelines help you to work with the user interface.

 
Guidelines
■ Use the cursor tooltip to view keyboard shortcut commands for tools. The cursor tooltip displays

when you hold it over a button on the ribbon. Instead of a command line in Revit, you can enter
keyboard shortcut commands to access tools. For example, enter VG to open the Visibility/
Graphics dialog box.

■ Control tooltip appearance by using the Options dialog box. This helps you view the appropriate
information for your experience level.

■ While working with a tool, when no other action is active, the Modify action is active by default.
To end a tool or operation quickly, press ESC twice to revert to the Modify status.

■ Use the Options Bar to select command-specific tools such as setting wall height while you are
placing walls. This is quicker than selecting and changing walls later.

■ Use the Project Browser to create, delete, change, or switch between views. This helps you quickly
manage the views in a project.

■ Read the hints and tips displayed on the status bar while working. These provide valuable
information about using the tools.

■ Hide the Project Browser while working on big drawings so as to expand the view window and
display a larger part of the drawing. You can also toggle the ribbon display to enlarge your view on
small screens.

----------------------------------------------------------------------------------------------------------------------------------------
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Lesson: Working with Revit Elements and
Lesson: Families
 

 

 

This lesson describes how to work with different types of Revit elements and families. You begin the
lesson by learning about building elements and families. Then, you learn about the recommended
practices for working with elements and families. The lesson concludes with an exercise on Revit
elements and families.

  
You create a building model by adding elements to it. These elements represent the different parts of
a building, such as windows and doors. Revit provides collections of similar types of elements, called
families. For example, a building model has different types of windows, such as fixed and opening,
which can be of different sizes. The fixed windows of different sizes can form a single family. You can
create custom building element families and modify them without additional programming.   
In the following illustration, the highlighted windows are of two different types but belong to a single
family. Similarly, the highlighted table and chair belong to different furniture families. 

 
Objectives

  
After completing this lesson, you will be able to:

■ Describe the different types of building elements.
■ Describe families.
■ State the recommended practices for working with Revit elements and families.
■ Work with Revit elements and families.
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About Building Elements
   

You use building elements, such as walls, doors, roofs, and windows, to create a building design. You
can place, create, and modify building elements.

 
Definition of Building Elements

  
Revit building elements are the building blocks of a project and you add them when you are
developing the project. When you place an element in a model, the individual element is called
an instance of that element type. Elements can be broadly classified into three classes: Model,
Annotation, and View.    
The following table briefly describes each element class.

 
  
Element Class

  
Description

  Model   Elements such as walls, windows, doors, and roofs that are used for the 3D
representation of building design. Model elements have a specific location
in the building.

  Annotation   Elements such as dimensions, tags, and elevation symbols that add
supplementary information required to document building design.
Annotation elements have a specific location on a view.
  Annotations also include datum elements such as levels, grids, and
reference planes that establish a context for project objects.

  View   Elements such as plans, elevations, sections, 3D perspectives, and
schedules that dynamically represent the parts of a building model.
Changes made to part of the model in one view are automatically updated
in all views that contain this part.
  Views have their own properties that can be modified or deleted. View
elements also control the annotation elements placed in a view. If you
delete a view, the annotations placed on the view are also deleted. View
elements do not control model elements but determine how model and
annotation elements are displayed.
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Building Model Element Types

  
Building model elements are categorized as host and component. The following table describes these
categories briefly.  

  
Element Type

  
Description

  Host   Elements such as walls, floors, roofs, and ceilings that form the basic
built-in-place structure of a building. Host elements can contain other
elements.

  Component   Elements such as windows, doors, and furniture that fill out the details of
building design. Components can be hosted, such as doors and windows
that are hosted by walls, or can be freestanding, such as columns or
furniture.

     
The following illustration categorizes building model elements.

  

 
Revit Elements as Objects

  
Elements such as walls, doors, and windows are recognized as actual objects. The properties of these
objects, such as structure and behavior, are called parameters. These properties simplify the process
of creating a building model.

  
For example, when you draw a wall element, you do not need to ensure that the wall layer is active
as in a conventional CAD application. You also do not need to separately draw the faces and internal
structural details of the wall element. The wall element is part of the wall category and has all the
visual attributes of a wall, such as the required lineweight and color. The wall element also behaves as
a wall. You can join it to other walls; connect it structurally to floors and ceilings, and place windows
and doors in it. Intelligence is programmed into elements so that their behavior is affected by the
relationships they share with other elements.
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Example of Building Elements
  

The following illustration shows various building elements.
  

  

 

  Host - wall attached to a roof

 

  Component - window placed in the wall

 

  Annotation - dimensions of the door

 

  Datum - levels

 

  View - plan view
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About Families
   

Families are groups of similar elements. You will use a large number of predefined families in your
projects. You can modify predefined families to suit project requirements. You can also create families
for your projects by using specific templates for doors, windows, furniture, electrical fixtures, tags,
and other components or annotation elements.

 
Definition of Families

  
A family integrates elements that have the same construction, use, and graphical representation.
For example, doors of different construction and use, such as double glass, overhead-sectional, and
single-flush, are generally found in different families. Within the double-glass door family, there may
be variations in door size, glass size and placement, or frame style; these variations are called types
within the family. Model families are divided into component families and system families.   
The following illustration shows different door families in the Revit library.

  

  

 

  Double glass door

 

  Overhead-sectional glass door

 

  Single-flush vision door

 

  Single-flush door
  
 

Family Types
  

Every family can contain multiple types. For example, families of tables might be created based on
usage or shape, such as conference table, coffee table, or dining table. Each family has types for
various sizes, such as round tables of different diameters.

  
Revit provides controls for how elements are constructed and located in a project using the Family,
Type, and Instance Properties dialog boxes. The family properties control the geometry, the type
properties control the size, and the instance properties control the location in space.
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The following illustration shows table families in a project file, each with different types of tables listed
by size.

  

 
Component and System Families

  
Component families are families of common components and symbols used in the building design that
have standard sizes, configurations, and parameters. You can load component family files into a project
or create them using family templates. You can also define properties and graphical representations
for component families. Most families are component families, such as doors, windows, and furniture,
which can exist outside a project.

  
System families have predefined parameters and graphical representations. They include walls,
dimensions, ceilings, roofs, and levels. System families are not available as external files for loading
into a project, nor can you create them.

  
You can modify the existing system families to suit project requirements or company standards. You
can use a predefined system family to generate new types in that family in a project. For example, the
structure of an exterior brick wall is predefined in the Basic Wall system family. You can create different
types of brick walls with different compositions. You can transfer system families between projects, if
required.

  
An in-place family is a special type of component family. It is specific to the project in which it is
created and edited. A roof cornice is an example of an in-place family. 
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Example of Families
   

The following table gives an example of family, type, and instance for a wall object.
 

  
Family

  
Example

  Family/System Family   Walls: Basic Wall

  Type   Exterior - Brick on CMU

  Instance  

 Actual user-drawn wall in a project
     

The following illustration shows Annotation Symbols, Doors, and Furniture families from the Project
Browser. You can load these component families from the libraries.
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Lesson: Starting a Project
 

  
This lesson describes how to start a new project with different templates. You begin the lesson by
learning about projects and project templates. Then, you learn about the default project template,
Revit file types, vector and raster data, toposurfaces, and some recommended practices for starting
a new project. The lesson concludes with exercises on creating a new project template and using
imported CAD data to start a project.  
The basic template files hold predefined information and settings for a project. When you create
a new project using any template, the project automatically takes the template settings. Every
organization has its own standards that can be applied to blank project setups for efficiency,
customization, and consistency. Useful modifications to standard content and settings can be captured
in template files or transferred between active projects for reuse.   
The following illustration shows a building model created using a project template.
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Objectives

  
After completing this lesson, you will be able to:

■ Describe a project.
■ Describe project templates.
■ Describe the default project template.
■ Describe Revit file types.
■ Describe vector and raster data.
■ Describe toposurfaces.
■ State the recommended practices for starting a new project.
■ Create a new project template.
■ Use imported CAD data to start a project. (Optional)

 

About Projects
   

A project provides all the essential information about a building model, such as the size and location
of components, materials used, and annotations. The display settings in a project file define the
appearance of the model in project views. Based on requirements, you can customize the default
settings of a project. The project file is based on a template that provides initial settings such as
material and display settings. You can customize templates. You can also start a project without using a
template.

 
Definition of a Project

  
A project is the entire building design and the associated documentation. It provides complete
information about various parametric building components required to represent a building model in
standard dimensional views and schedules.
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Recent Files Window

  
Every time you launch the software, a startup window named Recent Files is displayed. The window
provides links to the recently opened project files or family files with thumbnail images. Under
Projects, you can click the New link to open a new project using the default template. To create a new
project using templates other than the default, click the application button in the upper-left corner to
open the application menu and then click New > Project.  

 Recent Files window
   

You can open a recent project or family file by selecting its link in the Recent Files window. You can
click Open on the Quick Access toolbar in the upper-left corner of the window to open a file browser.
You can access the help and resource options using the Help drop-down on the InfoCenter toolbar
in the upper-right corner of the window. The Recent Files window also contains a link to the web
content.
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Creating a Building Model

  
You add parametric building components such as windows, doors, and walls to a project while creating
a building model. You can create plan, section, elevation, and 3D views and make the required changes
to complete the building model. Revit and BIM then ensure that the changes that you make in one
view propagate throughout the project, and all associated views automatically update to reflect the
change.

 
Specifying the Project Environment

  
You define the environment of a project while creating a building model. The project environment
includes the display and material settings such as colors, fill patterns, and line styles of various
components. Defining the environment imparts a standard appearance to the building model. You can
customize the environment settings at any point during the design process because they are saved
with the project.

 
Saving Project Files

  
When you begin a project or work on existing project files, you may want to save your work frequently.
Revit does not auto-save the project file. By default, Revit displays the Project Not Saved Recently
dialog box every 30 minutes. You can change the reminder interval setting using the Options dialog box
to suit your work style.

  
The following illustrations show the Project Not Saved Recently dialog box, and the Save Reminder
Interval settings in the Options dialog box.  
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Project Files Backup

  
Each time you save a project file, Revit creates a backup copy of the file. Backup copies of a file are
numbered incrementally, such as MyNewDesign.0001.rvt and MyNewDesign.0002.rvt. By default,
Revit maintains three backup copies of each project. You can change the number of backup copies
using the File Save Options dialog box accessed from the Save As dialog box.  

 
 

Examples of a Project
  

The following illustration shows a project file in plan, elevation, and 3D views.
  

  

 

  Plan view

 

  Elevation view

 

  3D view
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About Project Templates
   

A project file is based on a template that provides the initial settings, such as the material and display
settings. You can customize this template any time during the project. You can also start a project
without using a template.

 
Definition of a Project Template

  
A project template enables you to start a project by providing initial conditions such as the default
project units and settings, the default building levels and standard views, system families such as
walls, floors, and others, and preloaded component families. You can either select a template from the
template library, or you can save a project and use it as a new project template. New projects inherit
all the families, settings, and geometry from the starting template. 

 

Types of Project Templates
   

You can use the following standard project templates to start a project.
 

  
Template

  
Description

  Default   For new projects, unless you specify otherwise.

  Commercial   For designing commercial structures; includes additional levels and views.
This template is available in imperial installations only.

  Residential   For designing residential structures; includes additional levels and views.
This template is available in imperial installations only.

  Construction   For using views and preloaded schedules specific to the construction
industry.

  
 

Project Template Settings
  

You can modify the settings for views, levels, materials, and annotations using project templates.
Templates contain family content so that you can begin work quickly. You can provide wall types,
windows, and doors to your templates to suit the types of buildings your company designs. You can
specify building type in the template for generating energy calculations early in a project.

 
Additional Elements for Templates

  
You can create elements within project templates such as sheets, drafting views and details, schedules,
additional families, cameras, groups, detail groups, links, and import/export settings.
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View Templates

  
Views and their controls are very important for working effectively in Revit. You can create templates
for view types to hold settings and then apply these templates to views. For example, furniture
plans, floor finish plans, or electrical plans may all show the same area of a model, but they look very
different.

 
Starting Without a Template

  
You can start a project without using a template; in this case, the project contains only one level with
a plan view and a reflected ceiling plan view. You need to specify whether you want to use imperial or
metric units. The only wall types that load are basic, curtain, and stacked; no windows, doors, or other
components load; and no elevation view is created in the project.

 
Template File Type

  
Project template files have an .rte extension. By default, they are stored in the Imperial and Metric
Templates folders at the same level as the Imperial and Metric Library folders. 

 
Example of Using the Standard Template

  
The following illustration shows the location of the standard imperial templates.

  

 

  
File locations are different on Microsoft Windows XP and Microsoft Windows Vista
operating systems.
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About the Default Project Template
   

You can start a new project by using the default project template. This template provides default
settings for colors, line styles, and line weights, and the standard views of the building model.

 
Definition of the Default Project Template

  
The default project template, the default.rte (DefaultMetric.rte) file, is a standard template that
creates a new project with two levels, Level 1 and Level 2. It sets the default project units, imperial or
metric, and loads a subset of component families that you can use to create the building design.

 
Default Project Template Views

  
The default project template creates standard views of the building model. They are north, south, east,
and west elevations, two floor plans, two reflected ceiling plans, and a site plan. The floor plan view at
Level 1 is the default view. You can use this view to start creating the walls of the building model. If you
add more levels to the project, a plan view and a reflected ceiling plan view are automatically created
for each new level.   
The following illustration shows the default project template views.
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Default Project Template Settings
   

The following settings define the appearance of the default project template.
 

  
Setting

  
Description

  Colors   Define colors for line styles and families.

  Titleblocks   Load titleblock families for the sheets in your project.

  Families   Load the families you often use.

  Line styles   Define line styles for model components and detail lines in a project.

  Line weights   Define line weight for model and annotation components.

  Fill patterns   Define fill or hatch patterns. Fill patterns are commonly used in materials
and detailing.

  Materials   Define material appearance for model components, including fill patterns,
shading, and rendered images.

  Units   Specify the unit of measurement for lengths, angles, and slopes.

  Snaps   Set snapping increments for model views such as plan and 3D views.

  Dimensions   Define the look and size of dimensions for a project.

  Temporary
dimensions

  Set the display and placement of temporary dimensions.

  Object styles   Define the display of components in various views.
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Example of Default Project Template
 

 Object styles in the default template
 
 

About Revit File Types
   

Revit uses three types of files: project files, template files, and family files. Each one has a different file
extension.

 
Definition of Revit File Types

  
You can save the project in three file formats. Revit project files, in which you work to create building
models, have an .rvt extension. Revit family files, in which you create objects such as doors, windows,
annotations, symbols, and titleblocks that are loaded into the project files, have an .rfa extension.
Template files that are used to create project and family files have an .rte extension.

 
Saving Project Files

  
You can save and access template files on the local hard drive or on a network, depending on your
setup. You save project files on a network at a location that everybody in the design team can access.
You can also save a project file as a template file. 
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Example
   

The following illustrations show project and template file extensions and the default locations of
template files.

 

 

   Project and template file extensions   Default locations of template files
  

 

About Vector and Raster Data
   

You can use vector data from collaborators using CAD programs or from existing CAD files to create a
building model, a detail, or a toposurface. You can use raster data or image files as background for a
view, as sketch information to trace over when starting a building model, or as logos in titleblocks.

 
Definition of Vector and Raster Data

  
Vector data has both magnitude and direction. Vector graphics structure is used as a means of
coding line and area information in the form of units of data expressing magnitude, direction, and
connectivity.

 
 

Import Symbol
  

Elements such as lines, text, and blocks in imported vector data files become a single object called
an import symbol. You can change the appearance of elements within import symbols. You can
dimension individual parts in an import symbol and align objects with them. For example, you can
snap walls to the lines representing walls in an imported drawing.

 
2D Data

  
You can import all 2D objects in CAD files, except for rays and construction lines, as import symbols in
a drawing. You can explode an import symbol into text, curves, lines, and filled regions. You can also
import a DWG™ or DXF™ file that contains rendering data.

 
3D Data

  
You can import 3D data from other CAD software as import symbols. Surfaces, regions, faces, and 3D
solids are imported as 3D import symbols that have limited snapping. You can disassemble or explode
the import symbol. However, it is not possible to explode all 3D objects.   
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The following illustration shows imported 3D solid objects such as a box, a cone, and a cylinder in
hidden-lines view.

  

 
ACIS Objects

  
You can import ACIS objects from DWG, DXF, and SAT files. You can also import most DGN surfaces and
solids, except B-spline surfaces, from MicroStation software.

  

  
To use ACIS imports for face-based host commands, you import geometry into an in-
place family of the Mass or Generic Model category.

 
Line Weights

  
You can import pen numbers from a DWG or DXF file and map them to a line weight. Each layer in
the file is assigned a line weight based on pen number and line weight settings. Standard pen and
line weight mappings that follow predefined national standards are provided in the default project
template. You can also create your own mappings. When you save these mappings to a text file, they
become the set mappings for the project. These settings are retained within the project template.

 
Scaling

  
You can determine the scale factor of imported DWG or DXF files in your project from the import units
and scale factor properties of the import symbol. If you change the import units, the scale factor is
automatically updated. You can also specify a different scale factor. 
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Example
   

The following illustrations show an example of vector and raster data.
 

    Imported 3D objects as vector data   Imported raster image used as a logo in a titleblock
  

 

About Toposurfaces
   

For some projects, you may want to create toposurfaces to represent site conditions. Toposurfaces
hold different material definitions and heights and show contour lines. They can be modified to show
an existing site or proposed site grading. You create a toposurface by placing points individually or by
using points from an imported object or file.

 
Definition of Toposurfaces

  
A toposurface is a three-dimensional site object defined by points that can have different heights. It
also has a defined bottom level that is given a different height from the top. This bottom level appears
to have depth when viewed in an elevation or a section view.
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Example
  

The following illustration shows a toposurface with contour lines. The surface is subdivided into
different portions with each showing different materials such as asphalt, grass, and concrete. 

 

Guidelines for Starting a New Project
   

When you start a new project, you select either the default project template or a standard template
from the template library. Based on your requirements, you can customize the default template
settings and save the new settings as a template file. The following best practices help when starting a
project.
■ When you use a template provided by your organization, familiarize yourself with the levels, views,

and wall types before you create building model content. This helps you progress smoothly in the
building design and prevents inconsistencies in the design.

■ When you start a project using a standard template file, use the site view to create toposurfaces
and the lowest floor plan view to create walls at the lowest level of the building. This is because in
a project that uses the standard template, the lowest floor plan view and site view are at the same
elevation and show the same level, but they have different settings and purposes. Floor plan views
do not show toposurfaces by default. This helps you easily identify the site and floor plan views.

■ When you work on a multistory project, define additional levels for the floors, roofs, and tops of
exterior walls. This helps you create walls and other building elements with relevant constraints
that you can adjust quickly.

■ When you start your first project, begin with a standard template and then develop organization-
specific graphic standards, such as line weights, line styles, symbols, and annotations. You can
then use your first project file to create project templates for the organization. Building template
development time into the budget for the first few projects helps you standardize, and saves
considerable time in later projects.
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Chapter

3

Starting a Design
 
  

When you start a design project in Revit Architecture, you first need to learn how to organize your
content on levels and how to control the spacing and placement of structural elements for your
building design using grids. In this chapter, you learn how to work with levels and grids.

 
Chapter Objectives

  
After completing this chapter, you will be able to:

■ Create and modify levels in a building model.
■ Create and modify grids.
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Lesson: Creating and Modifying Levels
 

  
This lesson describes how to create and modify levels in a building model. You begin the lesson by
learning about levels and their uses. Then, you learn the steps and some recommended practices for
creating and modifying levels. The lesson concludes with an exercise on creating and modifying levels.  
You use levels to define a vertical height or a story within a building. In Revit Architecture, levels act as
horizontal reference planes to host building elements such as walls, roofs, and floors. With levels, you
determine and control the placement of elements vertically in a building model.   
The following illustration shows the various levels in a section view of a building model. 

 
Objectives

  
After completing this lesson, you will be able to:

■ Describe levels and their uses.
■ Identify the steps to create and modify levels.
■ State the recommended practices for creating and modifying levels.
■ Create and modify levels.
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About Levels
   

Levels define the vertical position and extent of building elements. Levels also form the work planes
for plan views and reflected ceiling views.

 
Definition of Levels

  
Levels are finite horizontal planes that act as references in a building model for level-hosted elements,
such as walls, roofs, floors, stairs, ramps, and ceilings. You use levels to define the vertical extents of
walls and the vertical placement of elements, such as furniture. There are two types of levels, story
and non-story.

 
Using Levels for Vertical Positioning

  
You create a level for each known story or floor platform, in a building model. Each plan view of
the model is at a level, and all elements placed in a plan view are based on the associated level for
that view. You can add new levels or modify existing levels at any time during the design process. All
elements set to a level move with the level.

 
Constraining Elements

  
When you create a wall, you place its base constraint on a level. You can set the top constraint for the
wall either to a level or to a specified height. If you set the top constraint to a height, you can later
modify it to a level. The advantage of constraining the tops of walls to a level is that if you change the
placement of the level, the height of all the walls constrained to that level changes accordingly.

 
Views Associated with Levels

  
A story level has a floor plan view and reflected ceiling plan view associated with it. Both views have
the same name as the level. If you change the name of the level, you are prompted to change the
names of the corresponding plan and reflected ceiling plan views.

  
When you create a new level, the option to make plan views for that level is activated by default. You
can create nonstory levels that do not have associated views by clearing the Make Plan View check box
on the Options Bar. You can use nonstory levels as top or bottom constraints for walls and other level-
based elements.

  
In Revit®, a story level is represented by a blue level head, and a nonstory level is represented by a
black level head.

 
Changing Level Extents

  
You can change the extents of a level in the views in which the level is visible. If you resize a level in the
Model Extent mode, the extents of that level change in all parallel views that have the Model Extent
control. If the level is in the View Specific Extent mode, any change in the extents of a level applies
only to the view in which the change is made.
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Example of Levels
  

The following illustrations show various levels. 

   
Levels 1 and 2 are story levels with associated floor and ceiling plans. The Top of Retaining Wall level is
a nonstory level with no floor or ceiling plan. 

 Section view with levels.
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Creating and Modifying Levels
   

When you use the default template to create projects, Level 1 and Level 2 are available as predefined
levels. These levels are displayed in the Project Browser under Floor Plan Views. Based on your
requirements, you can create new levels or modify the existing levels in a project.

  
You use the Level command to create levels. This command is active in the section or elevation views.
You sketch the required level lines. When you create a level, the Make Plan View check box on the
Options Bar is selected by default. You can choose to create a floor plan, a ceiling plan, or both.
However, if you clear the Make Plan View check box, the level is a reference but there is no view
associated with and named for the level and the level head is black. 

 

Procedure: Creating a Level
   

The following steps describe how to create a new level.
  

1.   Change the active view to a section or an elevation view.
 
2.   Click Home tab > Datum panel > Level.
 
3.   On the Options Bar:

■ Verify that the Make Plan View check box is selected if you want to create a story level.
■ Clear the Make Plan View check box if you want to create a nonstory level.

 
4.   Click Place Level tab > Draw panel > Pick Lines.
 
5.   On the Options Bar, specify the offset value.
 
6.   Place the cursor over the level line you want to offset to create the new level. Click to create the

new level line.
   
 

Procedure: Modifying a Level
   

The following steps describe how to modify a level.
  

1.
 Click a level to display the controls for the level line.

  
2.   To rename the level, click the level name and enter a new name.
 
3.   To change the level height, select the level line and do one of the following:

■ Drag the level to the new height. The height value field updates.
■ Click the level height field and enter a new height.
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4.

 To change the control from Model Extents to View Specific Extents, click the 3D control. The
value changes to 2D and the unfilled circle changes to a filled circle.

  
5.

 To change the control from View Specific Extents to Model Extents, click the 2D control. The
value changes to 3D and the filled circle changes to an open circle.

  
6.

 To offset the head from the level line, click the split-line symbol. The level head is offset and the
split-line symbol changes to a filled blue circle. You can drag this circle to reposition the head.

  
7.   To turn off the display of the level symbol and fields, clear the check box next to the level head.

  

 

Guidelines for Creating and Modifying Levels
   

The following practices are recommended for working effectively when creating and modifying the
levels in a building project.
■ Create levels in project template files that are appropriate for your projects so that you can use

these levels immediately when you start new projects. This helps you save time and eliminate the
possibility of errors.

■ Create levels without plan views during the concept design phase of a multistory project. This
ensures that the Project Browser list of views is simple. During project development, as you
determine the actual number of floors and start placing walls, you can create floor and ceiling plan
views as required.

■ Align the left and right ends of level lines so that they align with other levels. This helps you
simultaneously resize all aligned levels, which saves time and keeps the view window tidy. To align
a level line correctly, drag the level end so that it snaps and locks to the alignment line, which
appears when this level end is in line with the other level ends. You can unlock a level line at any
time if you need to adjust its position independently.

■ Ensure that you zoom in close enough on the level head while dragging it to select the correct
control point. This prevents you from picking the level line head offset control accidentally at
certain zoom scales.
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Chapter

4

The Basics of the Building Model
 
  

With Revit Architecture, you usually start with a basic floor plan and place elements in them. You can
then create many different types of walls. In this chapter, you learn about basic floor plans and walls,
and then you learn how to create, modify, and place walls. You also learn how to use editing tools to
add walls and components to a model quickly. After you have created walls, you can add doors and
windows to the building model.

  
A computable Autodesk® Revit® Architecture design model is devised for sustainability analyses—even
during early conceptual design. As soon as the layout of a building’s walls, windows, roofs, floors, and
interior partitions (elements that define a building’s thermal zones) are established, the information
employed to create a Revit model can be used to perform sustainability analyses.

 
Chapter Objectives

  
After completing this chapter, you will be able to:

■ Create a basic floor plan and place building elements in it.
■ Add and modify walls.
■ Create and modify compound walls.
■ Use editing tools to add and modify walls.
■ Add and modify doors in a building model.
■ Add and modify windows in a building model.
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Lesson: Adding and Modifying Walls
 

  
This lesson describes how to add and modify walls. You begin the lesson by learning about walls and
wall properties. Then, you learn the steps to modify walls. Next, you learn about joins, the steps to
edit and prevent wall joins, and about structural walls and foundations. The lesson concludes with
some recommended practices for working with walls and joins, followed by exercises on adding and
modifying walls and adding structural walls and footings.  
Walls in Revit are parametric elements that have height, thickness, materials, and other properties
associated with them.    
The following illustrations show various examples of adding and modifying walls in different views.

 

 

   Wall being added in a plan view   Wall selected in a section view
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    Wall selected in a 3D view   Same wall with a different wall type applied
  
 

Objectives
  

After completing this lesson, you will be able to:

■ Describe walls.
■ Describe wall properties.
■ Modify walls.
■ Describe joins.
■ Edit and prevent wall joins.
■ Describe structural walls and foundations.
■ State the recommended practices for adding and modifying walls.
■ Add and modify walls.
■ Add structural walls and footings. (Optional)
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About Walls
   

Walls are important elements that constitute the shell and internal partitions of a building model. In
Revit, walls are 3D parametric elements that host elements such as doors and windows, and define
rooms.

 
Definition of Walls

  
Walls in Revit are elements that represent the physical walls of a building. Like actual walls, they
can be monolithic or composed of parallel layers of materials. These layers can consist of a single
continuous plane of material such as Concrete Masonry Units (block) or multiple materials such as
gypsum board, studs, insulation, air spaces, bricks, and sheathing.

 
Wall Layers

  
Each layer within a wall element has a definite thickness and physical composition and a specific
purpose. For example, some layers provide structural support and some act as thermal barriers. Each
layer has material, thickness, and function parameters.   
The following illustration shows wall layers in a floor plan view with medium or fine detail level. 

 
Location Line of a Wall

  
You create a wall and its layers by sketching its location line in a plan view or 3D view. The location line
represents a vertical plane in the individual wall segment, which does not change with the wall type.
For example, if you draw a block wall and set its location line to Core Centerline, the location line does
not change when you change the structure of the wall to stud.

  
You can change the location line properties as an instance property of the wall. If you change the
location line for a wall, the wall does not move to align itself with the new location line. If you change
the wall type or orientation, the wall may change its position around the location line based on its
internal structure.   
In the following illustration, the location line, wall centerline, is represented by a dashed line. 

 

  
The centerlines of two collinear walls of different widths are automatically aligned.
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Wall Function Type Parameter

  
You use the wall function type parameter for scheduling walls in a project. You can set the wall
function type parameter to the following settings: Interior, Exterior, Retaining, Foundation, and Soffit.
For example, you can use the Retaining parameter to create a retaining wall.

 

  
A retaining wall is automatically set to be non-room bounding.

 
 

Example of a Wall
   

The following illustrations show a wall with different wall types applied.
 

 
  

  Stud framing with wood
siding wall

  Brick on concrete block
wall

  Solid concrete wall

  

 

About Wall Properties
   

You might face a situation, such as a change in level height, when you also need to modify the
associated walls. Revit allows you to change the properties of wall instances and wall types at any
stage of the design process.

 

  
Wall types and their material properties are important in deciding the energy
footprint of buildings.

 
Definition of Wall Properties

  
The properties of a wall define its appearance, structure, and size. The properties of a wall are
categorized into type and instance parameters. Some wall properties are common to all wall types,
and some are specific to only a few wall types.----------------------------------------------------------------------------------------------------------------------------------------
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Type Parameters

  
Type parameters are common to all the elements of a family type in a project. When you modify a
family type, the change is reflected throughout the project. For example, if you increase the thickness
of the stud layer in a wall type, all the walls with the same wall type update automatically in the
project.

  
To modify type parameters, you create a new wall type, change the required type parameters, and
then apply the new type to the selected walls. This prevents you from unintentionally modifying other
walls of the original type. You can modify the type parameters that affect the structure of a wall, its
layers and materials, behavior at inserts and ends, wall function, and display.   
The following illustration shows wall type parameters in the Type Properties dialog box.

  

 
Instance Parameters

  
When you change an instance parameter, the properties of only selected walls are altered. Some of
the instance parameters that you can change are Location Line, Base Constraint, Top Constraint, Room
Bounding, and Structural Usage.
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The following illustration shows instance parameters of a particular wall element. 

 
 

Example of Wall Properties
   

The following illustrations show a wall before and after modifying the Top Constraint parameter.
 

 

 

  Top Constraint parameter set to an
unconnected height

  Top Constraint parameter set to Level 3
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Modifying Walls
   

You can modify wall properties, such as length, height, and alignment, by changing the wall structure.
You can also modify wall profiles and add openings or cuts on walls. 

 

Procedure: Modifying Wall Properties
   

The following steps describe how to modify wall properties.
  

1.   In the view window, select the wall that you want to modify.
 
2.   To resize the wall, do one of the following:

■ Drag the end grip to a new length.
■ Select the temporary dimension for the wall and enter a new value.

 
3.   To flip the orientation of the wall between the exterior and the interior, click the flip arrows.

 Note: The flip arrows are always displayed on the exterior.
 
4.   To change the wall type:

■ Click Modify Walls tab > Element panel > Element Properties drop-down > Instance
Properties.

■ In the Instance Properties dialog box, select a new wall type from the Type list.
 
5.   To change the wall height or base and top constraints:

■ In the Instance Properties dialog box, change the Base Constraint parameter to move the
lower end of the wall up or down to other levels.

■ Set the Unconnected Height parameter to another value, if required.
■ Set the Top Constraint parameter to the appropriate level.

 
6.   Close the Instance Properties dialog box.
 
7.   To modify all instances of a wall type:

■ Right-click one instance of a wall. Click Select All Instances.
■ Click Modify Walls tab > Element panel > Element Properties drop-down > Instance

Properties.
■ Enter new values for the properties you want to change.
 Note: You can change all instances of a wall to a different type. The modified walls are located
relative to the location lines. The position of the location lines is based on the value of the
Location Line parameter for each wall segment.

   
 

Procedure: Modifying Wall Profiles
   

The following steps describe how to modify wall profiles.
  

1.   Open an elevation or section view from the Project Browser.
 
2.   Select the wall that you want to modify.
 
3.   Click Modify Walls tab > Modify Wall panel > Edit Profile.
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4.

 Select an existing wall boundary line. You can resize, redraw, or drag the line to a new position.
You can also draw new lines or arcs. The outline of the wall must be a closed series of lines or
arcs. If you open the boundary profile, you must add new lines to close the boundary.

  
5.   Click Finish Wall to complete the changes to the wall profile.

   
 

Procedure: Adding Openings to Walls
   

The following steps describe how to add openings to walls by editing the profile.
  

1.   Open an elevation or section view from the Project Browser.
 
2.   Select the wall that you want to modify.
 
3.   Click Modify Walls tab > Modify Wall panel > Edit Profile.
 
4.   On Modify Walls > Edit Profile tab, Draw panel, select the line type tool that you need to use.
 
5.   Draw the openings. Each opening must have a closed, nonintersecting boundary.
 
6.   Click Finish Wall to complete the changes to the wall profile.

  

 

About Joins
   

Joins help connect walls and show corners in a building design. Typically, walls join automatically to
form corners. When they do not join automatically, you specify a join to show the design intent.

 
Definition of Joins

  
Joins represent the display of the intersection of two walls in a plan view at the medium or fine
detail level. You use joins to clean up the intersection of wall layers. Based on the situation and the
components, you can specify joins using the Wall Joins option on the Edit Geometry panel of the
Modify tab. You can also use the Trim option on the Edit panel of the Modify tab.

 
Wall Joins

  
Revit automatically joins the intersection of walls. You can classify wall joins as Butt, Miter, and Square
Off. All wall joins are butt joins by default. Joins with angles less than 20 degrees are miter joins, and
joins with wall ends squared off to 90 degrees are square off joins.
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Radius Joins

  
You use radius joins to create rounded corners at wall intersections. You create radius joins by drawing
a wall using the Fillet Arc draw option and then picking two walls to create a fillet between them. You
can specify the radius or drag the radius wall to create the join. Revit does not allow you to specify
multiple radius joins at one location. The following illustration shows a radius join.  

 
 

Example of Joins
  

The following illustration shows different types of wall joins.
  

  

 

  Square Off join

 

  Butt join

 

  Miter join
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Editing and Preventing Wall Joins
   

The internal structure and layers of walls meet and join at corners. You can edit wall joins to suit design
requirements.

  
You can prevent walls from automatically joining with other walls when you want to display control
joins or expansion spaces in masonry walls. You may need to show an expansion joint of a few
millimeters between two walls while designing a building or you may be unable to show a particular
condition you need at a corner by joining the walls. You facilitate this expansion by preventing the ends
of walls from joining. 

 

Procedure: Editing a Wall Join
   

The following steps describe how to edit a wall join.
  

1.   Change the view to a plan view.
 
2.   Set the detail level of the view to medium or fine.
 
3.   Click Modify tab > Edit Geometry panel > Wall Joins.
 
4.

 Position the cursor over a wall join until a large square is displayed around the join. Click to select
the join.

  
5.   On the Options Bar, select Clean Join from the Display list to clean up the join.

 Tip: Select Don't Clean Join if you do not want the internal wall layers to join. The default display
setting is Use View Setting, which is Clean Join by default.

 
6.   Click a Configuration option to change the type of wall join to Butt, Miter, or Square Off.
 
7.   Click Next or Previous to toggle through the possible configurations.
 
8.   End the Wall Joins tool.

   
 

Procedure: Preventing a Wall Join
   

The following steps describe how to prevent a wall end from joining with another wall end.
  

1.   Click Modify tab > Edit Geometry panel > Wall Joins.
 
2.   Position the cursor over a free end of a wall until a large square is displayed.
 
3.   Click to select the end of the wall.
 
4.   On the Options Bar, click Disallow Join.

 Note: You can also select a wall in a plan view and right-click over a wall end grip. Click Disallow
Join.
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About Structural Walls and Foundations
   

Structural walls and foundations form an integral part of building design. You designate walls as
structural when you need to track their structural properties. You place foundations after adding
structural walls and columns.

 
Definition of Structural Walls and Foundations

  
Structural walls resist gravity and seismic forces. They are designed and scheduled accordingly.
Structural walls hold up walls and floors that are placed on top of them.

  
A structural wall in Revit differs from nonstructural walls by the value of an instance parameter
named Structural Usage. This parameter classifies walls as Non-bearing, Bearing, Shear, and Structural
Combined. For all walls placed using the Partition Wall option on the Build panel of the Home tab, this
property is set to Non-bearing by default. To create structural walls, use the Structural Wall option on
the Build panel of the Home tab.

  
Foundations are added to the base of a wall or column to provide support to it. Foundations in Revit
can be walls or foundation objects. You place foundation walls with the Wall tool. For foundation
walls, the base of the wall instance is set down from the level by the distance set in the Depth value
field, and the top of the wall is set to the current level. Foundation walls schedule as walls.

 
Structure Panel

  
To place foundations, either isolated or as wall footings, use the Foundation option on the Structure
panel of the Home tab.

  
Foundations placed under wall segments are different from foundation walls placed by using the Wall
or Structural Wall tools. A Foundation object snaps to the base of a wall or column and moves with
the wall when the base of the wall is moved up or down. Foundation objects schedule as foundations. 
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Example of Structural Walls and Foundations
   

The following illustrations show structural walls with various foundations.
 

 

 

  Structural wall with a foundation wall at
the base

  Structural wall with a foundation object attached to the
base

  

 

Guidelines for Adding and Modifying Walls
   

You add different types of walls while creating a building design. You can modify the properties of
the walls at any stage while creating a design and specify various joins between walls based on your
requirements. The following best practices help you work with walls and joins efficiently.

 
Guidelines for Working with Walls
■ Constrain the tops of walls to levels rather than to specific heights so that you can change the

height of the walls by changing the height of levels and have the walls, floors, and rooms adjust
automatically. This saves a significant amount of time and minimizes errors.

■ Specify the length of the wall by entering a value while drawing the wall so that the wall is
automatically drawn to size. This saves time and provides greater accuracy than specifying the
length while drawing.

■ Use the flip orientation double arrow controls while drawing or modifying walls to ensure that
the exterior faces of the exterior walls are properly set. By using these controls correctly, you can
display the compound walls properly at medium or fine detail level in the plan, elevation, section,
and 3D views. The wall flip control ensures an accurate display of wall layers.

■ Offset a wall from the cursor as you sketch it by specifying a value for Offset on the Options Bar.
You can also specify whether the offset is measured to the near edge, centerline, or far edge of the
wall. You save time when you specify a precise offset while placing walls.

■ Use generic wall types early in a project and replace them as the design develops with more
specific wall types. This allows you to populate a design quickly and make changes later.
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Guidelines for Working with Wall Joins
■ Display wall joins in plan views set to medium detail level and an appropriate view scale so that

you can clearly observe the wall joins. Revit manages line weights automatically according to view
scale.

■ You can use the Thin Lines display toggle from the Graphics panel on the View tab to observe wall
join intersections more clearly while joining complex wall types. Note that this is only a display
toggle and it affects all views.

■ Set wall join priorities in the Wall Properties dialog box. Wall layers with lower bracket numbers
in the Function field will cut layers with higher numbers. Setting priorities correctly allows you to
display most standard join conditions without additional view detailing.

■ Use detail lines and fill patterns to illustrate complex wall join specifications instead of using the
Edit Wall Joins option. Complex wall joins can produce a large number of configurations, and you
may have to try various configurations to find the desired one. Using detail lines and fill patterns
may be quicker and easier than trying to make the software calculate the join. 

 

Example of Guidelines for Working with Walls
   

The following illustrations show a wall in a plan view and the use of flip orientation controls.
 

 
 

  Flip orientation controls on the exterior
side

  Flip orientation controls with wall exterior reversed
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Example of Guidelines for Working with Wall Joins
   

The following illustrations show a wall join with and without the Thin Lines option selected.
 

 

   Thin Lines off   Thin Lines on
     

The following illustration shows stud walls meeting a block wall when Thin Lines is selected. The stud
wall type on the right has different join priorities from the wall on the left, so the layers join differently. 
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Lesson: Adding and Modifying Doors
 

  
This lesson describes how to add and modify doors in a building model. You begin the lesson by
learning about doors and the steps in the process of adding and modifying them. Next, you learn
the steps in the process of creating a new door type, followed by some recommended practices for
working with doors. The lesson concludes with an exercise on adding doors to a building model.  
Doors are wall-hosted component elements that you can place in any type of wall, including arc walls.
You can place doors in plan, elevation, and 3D views.  

 Two doors placed in a wall
 
 

Objectives
  

After completing this lesson, you will be able to:

■ Describe doors.
■ Identify the steps in the process of adding and modifying doors.
■ Create a new door type.
■ State the recommended practices for working with doors.
■ Add doors to a building model.
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About Doors
   

You create doors in a project by placing instances of door families. You can place doors in different
views and modify the door parameters. You can also modify the swing direction and the hinge
location using the control arrows.

 
Definition of Doors

  
Doors are wall-hosted elements; you can place a door only in an existing wall. When you add a door to
a wall in a plan, elevation, or 3D view, the software automatically cuts an opening in the wall and the
door is placed in that opening.

 
Doors as Component Elements

  
Doors are component elements. Therefore, you can create a new door family and save it as a separate
Revit family (RFA) file. You can then use this new door family in other projects.

 
Modifying Door Parameters

  
After you create a door, you can modify both the type parameters and instance parameters of the
door. Type parameters include dimensions and materials, and instance parameters include swing
direction and side, materials, and level. Changes that you make to the type parameters apply to all
the instances of that type of door in your project. However, changes that you make to the instance
parameters apply only to the selected instances of the door.

 
Placing a Door

  
You can place doors in the basic wall types in the plan, elevation, and 3D views using the Door tool.
While placing the door in a plan view, the swing direction of the door is set to the side of the wall that
you touch with the cursor. When the door is placed, you can change the swing direction and hinge
placement of the door with control arrows without exiting the Door tool. By selecting the Tag on
Placement check box on the Options Bar, you can tag doors as you place them. You can also tag doors
later, if you prefer.
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Example of Doors
  

The following illustration shows a door in a 3D view.
  

 

Process of Adding and Modifying Doors
   

After you add a door to a wall, you can modify its swing and direction. You use Instance Properties and
Type Properties from the Element Properties drop-down on the Element panel of the Place Door tab to
modify various properties of the door. 

 
Process: Adding and Modifying Doors

  
The following illustration displays the process of adding and modifying doors.
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The following steps describe the process of adding and modifying doors.

  
1.   Add door. You add a door in a basic wall by selecting the Door tool. You then select a door type from the

Type Selector drop-down and a wall in which you want to place the door.
 
2.   Modify instance parameters of door. You can modify the instance parameters, such as Level, Sill Height, and Phase, of a selected door.
 
3.   Modify type parameters of door. You can modify the type parameters, such as Door Material, Thickness, and Height, of a selected

door.
  

 

Creating a New Door Type
   

You can create new door types by modifying an existing door type to suit your requirements. The
process of creating a new door type is similar to creating new wall types or any new element type. You
use the Edit Type option in the Instance Properties dialog box and the Duplicate option in the Type
Properties dialog box to create a new type within the door family. 

 

Procedure: Creating a New Door Type
   

The following steps describe how to create a new door type.
  

1.   Click Home tab > Build panel > Door.
 
2.   Select a door type from the Type Selector drop-down.
 
3.   Open the Type Properties dialog box.
 
4.   In the Type Properties dialog box, click Duplicate.
 
5.   In the Name dialog box, enter a name for the new door type.
 
6.   Enter new values for the type parameters that you want to set for the new door type.

  

 

Guidelines for Working with Doors
   

The following recommended practices help you work with doors efficiently.
■ Learn the difference between doors in basic walls and doors in curtain walls to prevent errors.

You need to load specific door families for curtain walls from the library folder to place a door in
a curtain wall panel. Then, select the curtain wall panel where you want the door to appear and
change its Type property accordingly.

■ Clear the Tag on Placement check box to place doors without the door tags appearing
automatically. You can always tag doors later using specific commands. Placing doors without tags
keeps the screen less cluttered, and you can move doors without moving the associated tags,
which saves time.

■ Select the tag along with its door if you want to move a door that has been tagged while keeping
the tag in the same distance relationship with its host. You can select only the tag and move it
separately from the door to make sure that annotations do not obscure model graphics.

■ Use SPACEBAR to change the door swing while positioning the door for placement to save time.
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Chapter

5

Loading Additional Building
Components

 
  

In Revit Architecture, you use components of many different types to complete a design. You can load
components from external libraries, modify their properties, and create your own component types. In
this chapter, you learn how to load and place components into your designs. You also learn how to use
components from other designs and modify a family of components to suit your needs.

 
Chapter Objective

  
After completing this chapter, you will be able to work with component families in a project.
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Lesson: Working with Component Families
 

  
This lesson describes how to work with component families in a project. You begin the lesson by
learning about component families and the steps in the process of adding components. Next, you
learn about modifying component families and the steps to create and modify these families. The
lesson concludes with some recommended practices to add and modify component families, followed
by an exercise on loading component families and adding components in a project.  
A component family groups elements with a common set of parameters, identical use, and similar
graphical representation. Any modifications that you make to the parameters of a component family
are automatically reflected in every element of that family type.   
The following illustration shows domestic components, such as a washer/dryer and oven placed from
domestic equipment families, and counters and cabinets from casework families.

  

 
Objectives

  
After completing this lesson, you will be able to:

■ Describe component families.
■ Identify the steps in the process of adding components.
■ Describe how to modify component families.
■ Work with component families.
■ State the recommended practices for adding and modifying component families.
■ Load component families and add components in a project.
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About Component Families
   

You add elements such as windows and doors that represent the basic parts of a building model using
component families. You can also use these families to add freestanding elements, such as tables and
chairs, which do not require a host such as a wall or the floor. You can use predefined component
families shipped with Revit®, create your own custom families, or download custom families from the
Internet.

 
Definition of Component Families

  
A component can be any element of a building model that is placed and not drawn, such as a door,
a window, a desk, and a tree. All components are family-based. A component family, also known as
loadable family, is a grouping of components.

  
Each component family can have multiple components defined within it, each with a different size,
shape, material set, or other parameter variables.

  
Component family files have the .RFA extension.

 
Component Tool

  
You use the Component tool on the Build panel of the Home tab to place freestanding components
and component families, such as furniture and plumbing equipment, in a project. Windows, doors, and
columns have their own placement tools.

 
Load Family from Library

  
You can load component families into projects from external files in folders called libraries. You can
load families that you create or predefined families that are not currently in the project. Examples of
families that can be loaded are doors, windows, annotation symbols, and title blocks.

 
Autodesk Seek

  
You can also load these families using Autodesk Seek within Revit. Autodesk Seek takes you to the
Autodesk design content portal, where you can browse and download families. When you run the
search on Autodesk Seek, the following Web page opens:

  
http://seek.autodesk.com/   
The following illustration shows the Autodesk Seek panel. 

 After you download a family, you can load and save it in a project.
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You can access component libraries of other companies from the following sites:
 

■ Using the http://www.revitcity.com and http://www.augi.com URLs, you can
access the library of windows associated with the Anderson Corporation.

■ You can also access the http://www.turbosquid.com/revit site to purchase Family
files from TurboSquid, an Autodesk partner for Revit content.

 
Detail Components

  
Not every aspect of your project needs to be modeled in 3D. You can add detail components in
views to place 2D drafted representations of elements rather than model objects. By doing this
appropriately, you can save time. Detail components scale with the view so that they are always of the
correct size even if the scale of the view changes. Detail components can include elements such as a
two-by-four board, a metal stud, or a shim. Revit contains a large detail components library.

  
You can place detail components using the Detail Component tool in the Component drop-down on
the Detail panel of the Annotate tab.

 

  
Like dimensions and text notes, detail components are visible only in the view in
which they are placed.

   
The following illustration shows detail components being placed in a section.
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Locking Components

  
After placing a component, you can lock it to an element, such as a wall, so that the component moves
with the associated element. For example, if you lock a bed to a wall and then move the wall, the
bed moves with the wall. The software determines the element to which the component is locked.
However, you do not lose the ability to move the component independent of the associated element. 

 
Example of Component Families

  
The following illustration shows freestanding elements, tables and chairs, that belong to furniture
component families.
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Process of Adding Components
   

In addition to basic building components, you can add other components that represent actual parts
of a building and its environment, such as trees and parking spaces. 

 
Process: Adding Components

  
The process of adding components is shown in the following illustration: 

    
The following steps describe how to add components in a project.

  
1.   Open a plan view. Open a plan view.
 
2.   Activate the Component tool. Activate the Component tool by clicking Place a Component on the Component drop-down.
 
3.   Select a component. Select the desired component from the Type Selector drop-down. If the component you want is

not loaded into the project, you can load it from the library.
 
4.   Place the component. Place the component by positioning the cursor in the plan view where you want the component

to be displayed and then clicking to add the component.
 
5.   Adjust the component. Adjust the component, if required, by using editing tools such as Move, Copy, or Rotate on the

context tab. You can also change the component type.
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About Modifying Component Families
   

You can modify different types of component families in a project. You can also create a single family
and make many family types from it.

 
Definition of Modifying Component Families

  
Component family types are categorized by size and differ in the values of key dimensions. These
dimensions are defined as type parameters when the component is created. If you modify type
parameters, all instances of a component type are changed. You modify a component family in the
Family Editor. You can also duplicate and modify the family types to create new types.

 
Dimension Parameters

  
You can use the Family Editor to label and change the already labelled dimensions.

  
Each new family type has a property set that includes labeled dimensions and their values. You can
also add additional values for standard family parameters, such as material, model, manufacturer, and
type mark. You can create different family types within the project after loading a family into a project.

 
Instance Parameters and Shape Handles

  
When you create families, you set certain labeled dimensions as instance parameters that can be
modified when placed in a project. Labeled dimensions set as instance parameters can also have shape
handles. Shape handles are points that are displayed when the family is loaded into a project. Shape
handles allow you to drag and resize individual components in the project.

 
Standard Component Families

  
Standard component families are standard sizes and configurations of common components and
symbols used in the building design. You define the geometry and size of the family by modifying the
appropriate standard family template. You then save the family as a separate RFA file and can load the
family in any project.

 
Editing Standard Component Families

  
You can edit a loaded family and reload it into the same project or family or any new project. You can
save the family to a library with the same name or rename it before or after reloading the family in a
project. You cannot load or save system families.
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In-Place Families

  
An in-place family is created within the context of the current project. By creating in-place families,
you create custom components unique to a project or components that reference geometry within
the project. For example, if you need to create a reception desk that must fit between several other
items in a room, you can design the reception desk as an in-place furniture family.

  
You cannot save an in-place family to a file and load it in other projects. In-place family creation is an
advanced topic and is not covered in depth in this lesson.

  
When you edit an in-place family, you first select the entire family. Then, in the Family Editor, you
select the individual element and edit it in the sketch mode.

 
Copying Family Types Between Projects

  
You can copy family types from one project into another. The copied family type must have a unique
name. If the family type already exists in the target project, rename one family and then paste the
new family type into the project. You can copy in-place families from one project to another.

 
Family Templates

  
You create a family from a template that contains most of the information needed to place the family
in the project. Templates can include reference planes, dimensions, and predefined geometry, such as
window trim.    
There are six kinds of generic model family templates.

 
  
Family Template

  
Description

  Wall-based   For components inserted into walls, such as doors and windows.

  Ceiling-based   For components inserted into ceilings, such as sprinklers and recessed
lighting fixtures.

  Face-based   For components placed on mass faces or faces of walls and roofs, such as
equipment.

  Floor-based   For components inserted into floors, such as a heating register.

  Roof-based   For components inserted into roofs, such as soffits and fans.

  Stand-alone   For components that are not host-dependent, such as columns, furniture,
and appliances.

    
Wall-based, ceiling-based, face-based, floor-based, and roof-based templates are called host-based
templates. You can place a host-based family in a project only if an element of its host type is present.
Host-based components can include openings. When you place a component with an opening on the
host, it also cuts an opening in the host.

  
You can use stand-alone templates to place components anywhere in a project and you can dimension
them to other stand-alone or host-based templates.
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Example of Modifying Component Families
  

The following illustration shows two desk components. The lower one has been assigned different
material properties. This component is a new type within the family, and it can be saved back to the
library for reuse.

  

 

Working with Component Families
   

You can add a component family to a project and edit it within the project. You can create a new family
type or copy an existing family type from one project to another using the Project Browser or the view
window. 

 

Procedure: Adding New Family Types in a Project
   

The following steps describe how to create new family types in a project.
  

1.   In the drawing area, select an instance of the family.
 
2.   Click Element Properties drop-down > Type Properties.
 
3.   In the Type Properties dialog box, create a new family type by clicking Duplicate.

   
 

Procedure: Copying a Family Type from the Project Browser
   

The following steps describe how to copy family types from one project to another using the Project
Browser.

  
1.   Open the source project.
 
2.   In the Project Browser, expand Families until you can see the family type that you want to copy.
 
3.   Right-click the family type to be copied. Click Copy to Clipboard.
 
4.   Open the target project.
 
5.   Click Modify tab > Clipboard panel > Paste.
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Procedure: Copying a Family Type from the View Window
   

The following steps describe how to copy family types directly from the view window.
  

1.   Open the source project.
 
2.   In the view window, select an instance of the family type you want to copy. To select multiple

family types, such as a specific wall, window, and door, press CTRL and select each type.
 
3.   On the Clipboard panel, click Copy.
 
4.   Open the target project.
 
5.   Open the target view. Click once in the view window.
 
6.   On the Clipboard panel, click Paste.
 
7.   In the view window, drag the object or objects to the position where you want to place them.
 
8.   Click Modify Model Groups tab > Tools panel > Finish. The family type is displayed in the Project

Browser under its designated family.
   
 

Procedure: Editing a Family in a Project
   

The following steps describe how to edit a family in a project.
  

1.   Within a project, select the component family that you want to edit.
 
2.   On the Family panel, click Edit-in-Place.

 Note: You can also right-click in the view window and click Edit Family.
 
3.   Click Yes to open the family RFA file for editing.
 
4.   In the Family Editor, make modifications to the family.
 
5.   Save the family.
 
6.   On the Family Editor panel, click Load into Projects.

 Note: If only one project or family is open in the background, the family is loaded into the
project. Otherwise, a dialog box is displayed in which you can specify the projects or families into
which the edited family is to be loaded.

 
7.   If the modified family is used in the project, in the Reload Families dialog box, click Yes to

overwrite the existing version.
 
8.   Close the family file.
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Chapter

6

Viewing the Building Model
 
  

In Revit Architecture, you can view your building model in standard orthographic plan, elevation, and
section views, as well as 3D orthographic and perspective views. In this chapter, you learn how to
duplicate and manage views, control object visibility in views, and create elevation, section, and 3D
views.

 
Chapter Objectives

  
After completing this chapter, you will be able to:

■ Explore the different views displayed in the Project Browser and modify their properties.
■ Control the visibility and appearance of elements in different views.
■ Create and modify section and elevation views.
■ Create and modify 3D views.
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Lesson: Managing Views
 

  
This lesson describes how to use the different views displayed in the Project Browser. You begin
the lesson by learning about views and the steps to create and edit them. Then, you learn about
view properties, view templates, and some recommended practices for working with views. The
lesson concludes with an exercise on navigating different views displayed in the Project Browser and
modifying view properties.  
Views are essential elements of a project. They gather all the information related to a specific part
of a building model and represent it as required. The changes made to the properties of one view do
not affect the changes made to the properties of another view. However, if you change the model in a
particular view, the changes are visible in all the associated views as well.

  
In the following illustration, the properties of plan view are shown, such as View Scale set to 1/8"=1'-
0", Detail Level set to Coarse, and Model Graphics Style set to Wireframe. The plan view properties
are not reflected in the 3D view, which has a View Scale of 1"=1'-10", Detail Level set to Medium, and
Model Graphics Style set to Shading with Edges. However, when the size of a window is changed in
the plan view, the change is also reflected in the 3D view. Notice the selected window on the right of
the staircase in both the plan and 3D views.  

 
Objectives

  
After completing this lesson, you will be able to:

■ Describe views.
■ Create and edit views.
■ Describe view properties.
■ Describe view templates.
■ State the recommended practices for working with views.
■ Explore different views displayed in the Project Browser and modify view properties.

----------------------------------------------------------------------------------------------------------------------------------------

KKMSOFT

Downloaded From : www.EasyEngineering.net

Downloaded From : www.EasyEngineering.net

www.EasyEngineering.net

http://easyengineering.net
http://easyengineering.net


Lesson: Managing Views         ■        195

 

About Views
   

The Project Browser displays a list of all project views. You can create and browse the views to observe
different representations of a building model. When you open a view, or create a new view, the views
that were already open remain open and their settings do not change.

 
Definition of Views

  
Views provide a unique picture of a building model. You use views to display a building model from
different directions and references. You create a variety of views, such as plan, elevation, section,
and 3D views, for the building model. You can display a plan view as underlay in another plan view to
highlight the relationship between components on different levels.

  
When you start a project, certain views are created by default based on the project template that you
select. You can edit the properties of these views and create new views, as required. You can navigate
within a view using the mouse wheel, Steering Wheels, or the ViewCube.

  
Only one view can be active at any given time. However, you can switch between views in the middle
of an activity. For example, you can select a floor in the 3D view and edit it in the plan view. You can
also duplicate existing plan and 3D views to create new views.

 
Bidirectional Associativity

  
Bidirectional associativity ensures that the changes made in one view are automatically reflected in
all the associated views. It is applied to every component, view, and annotation of a building model.
For example, a change made to the dimensions of a window in the plan view is reflected in all the
associated views, such as elevations, the 3D view, and the window schedule view.
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Navigating Building Model Views

  
You use the Project Browser to navigate between different views of a building model. The Project
Browser displays views in a tree structure.

  
When you add a new level in a building model, a new floor plan view and a new ceiling plan view are
automatically created by default. However, you can bypass this behavior, if required.  

 Views of a building model in the Project Browser
  
 

Options for Duplicating Views
   

You duplicate views to allow you to use different settings for views that display the same portion of a
project model.

  
Following are the three options that you can use to duplicate views.

 
  
Option

  
Description

  Duplicate   Creates a view that is a copy of the primary view. A duplicate view displays model
elements but not annotation elements from the original view.

  Duplicate
with Detailing

  Creates a view that inherits all details of the primary view. A duplicate with
detailing view displays both model and annotation elements from the original
view.

  Duplicate as a
Dependent

  Creates a view that inherits view properties and view-specific elements from the
primary view. In a dependent view, you show only a specific area of the view. You
can insert Matchlines to indicate where the view is split, and view references to
link views. This option helps to create views that show portions of a plan when the
entire plan is too large to fit on a drawing sheet.
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Underlay

  
You use the underlay property of a plan view to display another plan view of the model under the
current plan view. Underlay can be above or below the current level and appears in halftone. You
use underlay to understand the relationship between components on different floors. You can select
and modify elements in the underlay or snap to the underlay elements for the purpose of the design
layout.   
In the following illustration, the halftone lines show a lower-level plan view as underlay in the current
plan view.
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Example of Views
  

The following illustration shows the different views of a building model.
  

  

 

  Plan view

 

  Section view

 

  Elevation view

 

  3D view
  

 

Creating and Editing Views
   

When you create a building model, you will need to work on different views such as floor plans and
ceiling plans. You use the Create panel of the View tab to create new views. You can also duplicate
existing views and change their properties using the Project Browser.

  
You use the horizontal and vertical scroll bars of the view window to pan horizontally or vertically. You
can use the Steering Wheels control on the Navigation Bar to scroll or zoom in a flat view and spin the
3D view. You use ViewCube in 3D views to spin the model or reorient the view. You can use the mouse----------------------------------------------------------------------------------------------------------------------------------------
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wheel to zoom and pan in any model view, and you can use the mouse wheel and the SHIFT key to
spin the model.

  
You can see all the open views together by using the Tile or Cascade option on the Windows panel of
the View tab.

  
You can also identify a split so that you can place portions of large views on small sheets correctly
in a view by adding a Matchline. Matchlines are 3D objects in plan views. You can set their vertical
extents so that they display only at certain levels. Matchlines coordinate views when they are placed
on sheets.

  
While duplicating and cropping views that are too large to fit on your sheet, you can add a Matchline
to indicate the appropriate crop location. You can customize the look of the Matchline by editing the
line weight, color, and pattern. 

 

Procedure: Creating a New View
   

The following steps describe how to create new views of various types.
  

1.   To create a floor plan, click View tab > Create panel > Plan Views drop-down > Floor Plan.
 
2.   In the New Plan dialog box:

■ Select the level at which you want to create the view.
■ Clear the Do Not Duplicate Existing Views check box to create a duplicate view.

 
3.   To create an elevation view:

■ Make a plan view as the active view.
■ Click View tab > Create panel > Elevation drop-down > Elevation.
■ Set the elevation marker at the desired elevation location to create a new elevation view.

 
4.

 To create a section:
■ Click Create panel > Section.
■ Select two points to sketch a new location for the section line.

  Note: You can place a section in a plan, section, or elevation view.
 
5.   To create a new component schedule, click Create panel > Schedules drop-down > Schedule/

Quantities. In Revit®, Schedules are views as well.
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6.

 In the New Schedule dialog box, select a Category for the new schedule.

  
7.

 In the Schedule Properties dialog box, add the parameters you want to create in the view.

    
 

Procedure: Adding a Matchline
   

The following steps describe how to add a Matchline to a view.
  

1.   Open the original view from which you created the duplicate or dependant view.
 
2.   On the View Control Bar, click Show Crop Region to make the crop region visible.
 
3.   Click View tab > Sheet Composition panel > Matchline.
 
4.

 Sketch a Matchline of the required length in the view window.
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5.   Select Finish Matchline to finish sketching the Matchline.
 
6.   Crop the view to the Matchline from one direction.
 
7.   Open the duplicated or dependant view and make the crop region of the view visible.
 
8.   Crop the view to the Matchline from the other direction. When both views are placed on sheets,

the Matchline indicates where they meet.
 
9.   You can place view reference annotations near Matchlines to identify the connected views by

their sheet and detail numbers.
  

 

View Properties
   

You use view properties to set and modify different parameters associated with the active view, such
as scale, graphics style, and underlay. Certain view instance properties are available on the View
Control Bar at the bottom of each view window. You can modify the properties of a view by using the
Instance Properties dialog box for that view.   
The following illustration shows the Instance Properties dialog box for a plan view. 

----------------------------------------------------------------------------------------------------------------------------------------

KKMSOFT

Downloaded From : www.EasyEngineering.net

Downloaded From : www.EasyEngineering.net

www.EasyEngineering.net

http://easyengineering.net
http://easyengineering.net


202          ■         Chapter 6: Viewing the Building Model

 
View Property Parameters

  
View property parameters affect the way a building model is displayed in the active view window.   
Various types of views have some properties that may differ. The following illustration shows
parameters in the Instance Properties dialog box of a plan view. 

    
The following table describes the key parameters available in the Instance Properties dialog box of a
view.

 
  
Parameter

  
Description

  View Scale   Changes the scale of the view as it appears on the drawing sheet.

  Scale Value   Defines a custom scale value. Scale Value is enabled when Custom is
selected for View Scale.

  Display Model   Comprises three settings. The Normal setting displays all elements
normally. It is intended for all non-detail views. The Do Not Display setting
hides the model and displays only detailed view-specific elements. These
elements include lines, regions, dimensions, text, and symbols. The As
Underlay setting displays all detail view-specific elements normally and
model elements appear dimmed.

  Detail Level   Applies a Coarse, Medium, or Fine detail level setting to the view scale.
This setting overrides the automatic detail level setting for the view.

  Visibility/Graphics
Overrides

  Controls the visibility of objects by category in your view. You can specify
visibility settings using the Visibility/Graphic Overrides dialog box.
  This is a powerful feature of Revit and you will learn more about it later.
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Parameter

  
Description

  Model Graphics Style   Specifies different graphic styles for a project view. The styles are Hidden
Line, Wireframe, Shading, and Shading with Edges.

  Graphic Display
Options

  Controls the shadows and silhouette lines in the view.

  Discipline   Specifies the discipline of the project view and controls the display of
model objects. You can select Architectural, Structural, Mechanical,
Electrical, and Coordination disciplines for the project.

  Color Scheme   Specifies a color pattern to be applied when rooms are visible in the view.

  View Name   Displays the name of the active view. The view name also appears in the
Project Browser and on the title bar of the view.

  Title on Sheet   Shows the name of the view as it appears on the sheet; the name is
separate from the value in the View Name property. This parameter is not
available for sheet views.

  View Range   Controls the specific geometric planes that define the boundaries of plan
views. You can set these boundaries by defining the height of the Top Clip
Plane, the Cut Plane, and the Bottom Clip Plane.

  Phase Filter   Applies a specific phase filter to a view. This parameter controls the
appearance of model objects based on their phase status.

  Phase   Displays the specific phase of a view. View Phase, Phase Filter, and Object
Phase work together to determine which model components are visible in
the view and how they appear graphically.

  Crop View and Crop
Region Visible

  Sets a boundary around the building model. You can select the boundary
and resize it using the drag controls. The visibility of the model changes
when you resize the boundary. To turn off cropping, clear the Crop Region
check box. To turn off the boundary and maintain the cropping, clear the
Crop Region Visible check box.

  
 

View Range
  

Plan views are three-dimensional. All plan views and reflected ceiling plan views have an instance
property called View Range, which is a group of horizontal planes that affect object visibility and
appearance in a view. View Range has four horizontal planes: Top, Cut plane, Bottom, and View Depth.
The Top and Bottom planes represent the top and bottom extents of the view, respectively. The Cut
plane determines the display of elements in a view. While model elements above the Cut plane are not
displayed, model elements below the Cut plane are in Projected lineweight. Model elements that pass
through the Cut plane are displayed in Cut lineweight, which is heavier than Projected. When the View
Depth plane is set below the Bottom plane, the view displays the elements below the Bottom plane,
down to the View Depth level, in Beyond lineweight, which is lighter than Projected.
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The following illustration shows walls that are Cut in the view, Projected, which is below the Cut plane
and above the Bottom plane, and Beyond, which is below the Bottom plane and above the View
Depth plane. 

 Walls shown as Cut, Projected, and Beyond
 
 

View Control Bar
  

The View Control Bar located in the lower-left corner of the view window provides quick access to
select view properties that affect the way a building model is displayed in the view window. You
access the view properties using the buttons on the View Control Bar: Scale, Detail Level, Model
Graphics Style, Shadows Off, Crop View, Show Crop Region, Temporary Hide/Isolate, and Reveal
Hidden Elements.

 
Scale

  
You can change the view scale values in the drawing by using Scale on the View Control Bar. View scale
determines how the view will fit on a sheet. You can select from a set of predefined scale values, or
specify a custom scale value for the drawing. Annotations resize automatically when the view scale
changes.   
The following illustration shows various imperial scale options available on the View Control Bar. 
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Detail Level

  
You use Detail Level to specify the extent of detail that you wish to display in a view. Detail level affects
the display of component geometry, and is coordinated with view scale. You can change the detail
level of a view to coarse, medium, and fine. Coarse displays only the outlines of walls, floors, roofs,
and any applied coarse detail fill patterns. The medium and fine levels display the internal structures of
compound components.  

  

 

  Coarse level display of a compound wall

 

  Medium and Fine level display of the same wall
  
 

Model Graphics Style
  

You use Model Graphics Style to select graphic styles, such as Wireframe, Hidden Line, Shading, and
Shading with Edges, for the building model.   
The different types of Model Graphics Style options applied to a building model are shown.

  

  

 

  Wireframe

 

  Hidden Line

 

  Shading

 

  Shading with Edges
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Shadows

  
You use the Shadows property to turn the shadows on or off in a view. Some jurisdictions may require
shadows to be visible as part of the planning and approval process. The Shadows parameter is useful
in such scenarios.  

  

 

  Building model with shadows on

 

  Building model with shadows off
  
 

Crop View
  

You use Crop View to display and modify the boundaries of a view. You can hide or show a crop
region in a view. When a crop region is visible, you can resize its edges by dragging the Far Clip Plane
indicators. You create a cropped copy of a large view so that working in or displaying a portion of the
original view becomes easy.  

  

 

  Plan view without cropping

 

  Plan view with cropping
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Temporary Hide/Isolate

  
You use the Temporary Hide/Isolate property to temporarily hide selected elements in the active
view. This option is useful when you want to view or edit the elements of a certain category in a view
because the options for an element are enabled only when it is selected in the active view. You can
hide a particular element in a view with Hide, and you can isolate an element by hiding all other
elements in a view with Isolate. Hide/Isolate does not affect printing of objects.   
The following illustration shows instances of selecting, isolating, and hiding a wall category.

  

  

 

  Upper wall selected

 

  Wall category isolated

 

  Wall category hidden
  
 

Thin Lines
  

You use thin lines to toggle the display of line widths on and off in a building model. Revit shows lines
with applied widths by default, so that each view approximates how it will print according to drafting
standards. With Thin Lines turned on, you can easily differentiate between closely spaced lines when
you need to work in a busy part of a view. Thin Lines is available on the Graphics panel of the View tab.
It affects all the views.

  
In the following illustration, when thin lines are turned on, you can view the exact intersection detail at
the top of the wall, and when thin lines are turned off, the slanting roof hides the top of the wall.  

  

 

  Thin lines turned off

 

  Thin lines turned on
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Lesson: Working with Section and Elevation
Lesson: Views
 

  
This lesson describes how to create and modify section and elevation views. You begin the lesson by
learning about section and elevation views. Then, you learn some recommended practices for creating
these views. The lesson concludes with an exercise on creating and modifying section and elevation
views.  
You create a section view to represent a vertical cross section of a building model to display the
structure. You create an elevation view to represent a side profile of a building model to show
materials. You also use the section and elevation views to sketch levels and add design elements to
your building model.    
The following illustrations show a section and an elevation view of a building.

 

 

 

  Section view   Elevation view
  
 

Objectives
  

After completing this lesson, you will be able to:

■ Describe the characteristics of a section view.
■ Describe the characteristics of an elevation view.
■ State the recommended practices for creating section and elevation views.
■ Create and modify section and elevation views.

----------------------------------------------------------------------------------------------------------------------------------------

KKMSOFT

Downloaded From : www.EasyEngineering.net

Downloaded From : www.EasyEngineering.net

www.EasyEngineering.net

http://easyengineering.net
http://easyengineering.net


226          ■         Chapter 6: Viewing the Building Model

 

About Section Views
   

You use section views to see the elevation of a building model along a specific vertical plane. You can
split a section into segments. You can also create reference sections for existing views.

 
Definition of Section Views

  
A section is a cross section in a building model that you place by drawing a line. The view associated
with this section is known as a section view.

  
A section cuts through a model so that the interiors of model components along the section line
are visible. There are three default types of sections: building, wall, and detail. Each type of section
appears in a separate listing in the Project Browser.

 
Segments in Section Views

  
You can split sections into segments that are at right angles to the view direction. You can then use
these segments to show parts of a building model located at different distances. You do not need
to create a separate section view for each segment. For example, to show a section that displays a
portion of the exterior, a portion of a room, and a portion of another room, you split a section line
into segments, as shown.  

  

 

  Segments in plan view

 

  Section view
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References in Section Views

  
Reference sections are sections that reference an existing view. You can place reference sections in
plan, elevation, section, drafting, and callout views. Reference sections can reference section views,
callouts of section views, and drafting views. When you add a reference section to a building model, a
new view is not created.

  
There is no parametric relationship between the reference section and the referenced view. Therefore,
when you resize the section line of a reference section, it does not affect the crop region of the
referenced view.  

 A reference section based on an existing section
 
 

Section Tag Visibility of Section Views
  

Section tags, which include section head, section tail, and break control, are symbols associated with
section views. You see section tags in plan, elevation, or other section views, as long as the crop region
of the section intersects the view range. For example, if you resize the crop region of a section view so
that it does not intersect the view range of a plan view, the section symbol is not displayed in the plan
view.

  
Section symbols are visible in elevation views even if the crop region is turned off. A section symbol is
displayed in elevation view if the section line intersects the elevation clip plane. If you resize the clip
plane so that it no longer intersects the section line, the section is not displayed in the elevation view.

  
You can set section tags so that they display only at certain view scales. For instance, site plan views in
a large scale do not show section lines through walls, but floor plan views show the sections. By setting
the section view scale display parameter, you do not need to hide or display the section line in each
view.
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Line Breaks in Section Views

  
If you do not want the section line to be displayed in the building model in a specific view, you can
break it into disconnected segments. You use the break control to break section lines and to join
broken section lines.    
The following illustrations show breaking and rejoining a section line.

 

    Section break in the middle of a section   A rejoined section line
   

  
A break in a section line is view specific and affects the display of the section only in
the view in which the break was made.

 
Type Properties of Section Views

  
Each section view has type parameters that control the section tags, callout tags, and reference labels.
You set the properties of these type parameters in the Type Properties dialog box. You can define the
appearance of section tags and callout tags by selecting Section Tags from the Settings drop-down on
the Project Settings panel of the Manage tab.

  
The reference label parameter in the Type Properties dialog box sets the text displayed next to the
section bubble of a reference section.

  
A section bubble is the symbol on a section line that is created at the end containing the section
head. A section bubble contains the detail number for the section, which is automatically populated
when the section view is placed on a sheet. A section bubble also displays a default arrow symbol that
points in the direction of the section view. A section line also displays a symbol at the tail end. You can
toggle the symbols displayed at the ends of a section line.

  
The Revit default templates contain predefined section types such as Building Sections, Wall Sections,
and Detail Sections. You can also create various section types. The custom section types are listed
separately in the Project Browser.

----------------------------------------------------------------------------------------------------------------------------------------

KKMSOFT

Downloaded From : www.EasyEngineering.net

Downloaded From : www.EasyEngineering.net

www.EasyEngineering.net

http://easyengineering.net
http://easyengineering.net


Lesson: Working with Section and Elevation Views       ■       229

 
Instance Properties of Section Views

  
Section views have instance properties, such as scale, detail level, model graphics style, and shadows.
Section views are 3D. You can control the depth of a section by dragging the Far Clip Plane indicator in
a plan view or by adjusting the Far Clip Offset value in the View Properties dialog box.  

    Far Clip Plane indicator in a plan view   Far Clip Offset in the View Properties dialog box
    

You can use the Far Clip property of a section view to specify how the view represents its clip depth
on the faces of objects that are oblique to the view. The Far Clip property of a section view has three
options: No Clip, Clip Without Line, and Clip With Line.   
The following illustration shows the options of the Far Clip property of a section view. 
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Example of Section Views
  

The following illustrations show section views of a building.
  

 Section view
   

 Detail section view
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About Elevation Views
   

You use elevation views to show a horizontal view of a building model from a certain point. Elevation
views show levels, grids, door and window placement, and materials. Interior elevation views show the
detailed features and finishes of interior walls.

 
Definition of Elevation Views

  
Elevation views that are part of the default project template provide a snapshot of a building model
from the specified direction. When you create a project using a project template, the north, south,
east, and west elevation views are automatically created.

 
Elevation Tag Visibility in Plan Views

  
You designate elevation views with elevation tags in plan views. An elevation tag is an elevation symbol
with an arrowhead that snaps to walls when you place it in a view.

  
The elevation view indicator specifies the crop region of the elevation view that intersects the view
range of the plan view.

 
Type Properties in Elevation Views

  
Every elevation view has type parameters that control tags and labels. You set the properties of these
type parameters in the Type Properties dialog box. You can define the appearance of elevation tags by
selecting Section Tags in the Settings drop-down of the Project Settings panel of the Manage tab. The
reference label parameter of reference elevations specifies the text that is displayed next to the tag of
a reference elevation.

  
The software contains predefined elevation types such as Exterior and Interior elevations. You can also
create various elevation types. The custom elevation types are listed separately in the Project Browser.

 
Instance Properties of Elevation Views

  
Elevation views have instance properties, such as scale, detail level, model graphics style, and
shadows. Elevations are 3D. You can control the depth of an elevation view by dragging the Far Clip
Plane indicator in a plan view or by adjusting the Far Clip Offset value in the View Properties dialog
box.  

    Far Clip Plane indicator in a plan view   Far Clip Offset in the View Properties dialog box
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You can use the Far Clip property of an elevation view to specify how the view represents its clip
depth on the faces of objects that are oblique to the view. The Far Clip property of an elevation view
has three options—No Clip, Clip Without Line, and Clip With Line.

 
References in Elevation Views

  
Reference elevations are elevations that reference an existing view. You can place reference elevations
in plan, drafting, and callout views. Reference elevations can reference elevation views, callouts of
elevation views, and drafting views. When you add a reference elevation to a building model, a new
view is not created.

 
Elevation View Symbols

  
Elevations in a plan view are specified by elevation tags. These tags are complex objects consisting of
round or square symbols and arrow indicators for the four views that you can create for a tag.    
The following illustrations show the elevation view symbols that appear when you activate the
Elevation tool by clicking Elevation on the Create panel of the View tab. By convention, the round
symbol denotes an interior elevation and the square symbol denotes an exterior elevation.

 

  
  Interior elevation symbol   Exterior elevation symbol

  
 

Activating Elevation Views
  

You can activate up to four elevation views from an elevation tag. When you select an elevation tag,
check boxes for each direction are displayed. You can select the check boxes for the required elevation
views to appear in the Project Browser.
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The following illustration shows an elevation symbol with check boxes for creating elevation views. The
circular arrow enables you to rotate the elevation tag and the associated view.

  

  

 

  Check box for creating elevation view

 

  Circular arrow for rotating tag
  
 

Framing Elevations
  

Framing elevations are useful for adding vertical bracing to a building model or for any task that
requires quick work plane alignment to a grid or to a named reference plane. When you add a framing
elevation, Revit sets the work plane and Far Clip Offset at the selected grid or reference plane. Framing
elevations snap to grid lines and ignore walls.

  
You create a framing elevation by clicking Framing Elevation in the Elevation drop-down of the Create
panel of the View tab. You can also select the Attach to Grid check box on the Options Bar while
placing a standard elevation. 

 
Example of Elevation Views

  
The following illustrations show various elevation views of a building model.

  

 Exterior elevation view
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 Interior elevation view
   

 Exterior elevation view with shadows
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Guidelines for Creating Section and Elevation Views
   

The following are recommended practices for creating elevation and section views.
 

Guidelines
■ During the design development process, you can create section and elevation views to check

specific design areas. You can create temporary section and elevation view types in the Project
Browser to segregate temporary views. You can also customize the graphic appearance of the tags
for such views.

■ The view name in the Project Browser is different from the view name when you place it on a
sheet, therefore, you can use a descriptive and meaningful name in the Project Browser and a
standard name in the document set. This is to easily identify views and save time during the design
development process.

■ You do not have to spend time populating elevation and section bubbles with text and numbers
because Revit automatically numbers them when you place the views on sheets.

■ Annotate views only when the design development process is near completion, because the
annotations may need to be updated if you change the building model during the process.

■ You can pin section and elevation tags in place in plan views before adding text, detail components,
and other annotations to the elevations and sections. Pinning prevents the view tag from being
inadvertently moved.

■ Elevation tags are separate from elevation view location lines. You can move elevation tags for
clarity in plan views without changing the elevation location.
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Lesson: Creating and Modifying 3D Views
 

  
This lesson describes how to create and modify 3D views. You begin the lesson by learning about
3D view types and cameras. Next, you learn the steps to create and modify camera views and some
recommended practices for creating and modifying 3D views. The lesson concludes with exercises on
creating the 3D perspective and 3D orthographic views and creating a section box 3D view.  
You can create 3D views of a building model to help your design team or client visualize the model.
You can also use 3D views to review alternative designs.  

 3D perspective view of a building model
 
 

Objectives
  

After completing this lesson, you will be able to:

■ Describe 3D view types.
■ Describe cameras.
■ Create and modify camera views.
■ State the recommended practices for creating and modifying 3D views.
■ Create the 3D perspective and 3D orthographic views.
■ Create a section box 3D view. (Optional)
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About 3D Views
   

You can present a building model by using two types of 3D views, perspective and orthographic. These
views represent your design vision and demonstrate the form and function of the building model.

 
Definition of 3D Views

  
A 3D view shows the building model from a point of view using the camera. You can position the
camera anywhere and create a 3D view of the model. The direction of the camera is determined by
positioning the view target. You can increase or decrease the angle of view of the camera by adjusting
the side clipping boundaries of the view.

 
3D View Types

  
In the perspective view, objects that are far from the camera appear smaller than objects of similar
size that are closer to the camera. In this view, the receding parallel lines appear to converge to
vanishing points.  

 Perspective 3D view of a building
   

In the orthographic view, objects that are far from the camera are the same size as objects of similar
size that are closer to the camera. In this view, the receding parallel lines remain parallel and do not
appear to converge at a vanishing point.  

 Orthographic 3D view of a building
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You can orient 3D views to any direction and save them with different names.

 
Section Box Views

  
A section box is a 3D crop boundary created in a 3D view. You create section box views to display a
specific part of the 3D view, which helps isolate a part of a building model for the purpose of study or
illustration.

  
To create a section box in a perspective or orthographic view, you enable the section box by selecting
the Section Box check box in the Instance Properties dialog box. The section box provides triangular
control grips that you can use to crop the required portion of the building model and limit the scope
of visibility in the 3D view.

  
You can use the section box view to control lighting during the rendering process and save processor
time. You can hide the section box in the view and retain its crop effect.   
The following illustration shows the section box view. 

 
Mouse Navigation

  
A mouse wheel provides zoom, pan, and orbit controls in a 3D view. The pan and orbit controls allow
you to orient a particular view to give you the view you want.

  
You move the mouse wheel to zoom in and zoom out a view. You can also use the CTRL key and the
mouse wheel to zoom. To pan the view (side-to-side), you hold down the mouse wheel. To orbit in a
view, you use the mouse wheel and the SHIFT key at the same time.
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Steering Wheels Navigation

  
You open the Steering Wheels by clicking the Steering Wheel on the Navigation Bar or pressing
F8. The Steering Wheel can display as the full navigation wheel, the view object wheel, or the tour
building wheel. The three wheels provide controls that allow you to zoom, pan, orbit, place the view
center, look around from the camera position, move the model up or down, walk around the view (in
perspectives only), and rewind through recent actions. You can control the appearance of the Steering
Wheel using the Options dialog box.  

     Full navigation wheel   View object wheel   Tour building wheel
      

The following table describes the options on the three Steering Wheels.
 

  
Wheel

  
Button

  
Description

  Full
navigation
wheel

  Orbit   Rotates the camera eye about the entire model or selected
objects.

    Zoom   Magnifies the view.

    Pan   Moves the view left, right, up, or down.

    Rewind   Steps back through recent actions.

    Center   Sets the center for Zoom or Orbit.

    Walk   Moves the camera toward the model in the direction the cursor is
dragged.

    Look   Spins the camera while holding its position.

    Up/Down   Moves the camera up or down, holding the same target point.
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Wheel

  
Button

  
Description

  View object
wheel

  Center   Sets the center for Zoom or Orbit.

    Zoom   Magnifies the view.

    Rewind   Steps back through recent actions.

    Orbit   Rotates the camera eye about the entire model or selected
objects.

  Tour building
wheel

  Forward   Zooms in toward a selected target.

    Look   Spins the camera while holding its position.

    Rewind   Steps back through recent actions.

    Up/Down   Moves the camera up or down, holding the same target point.
  
 

Mini Wheels Navigation
  

You can also open mini versions of the three wheels: full navigation wheel, view object wheel, and
tour building wheel. Mini wheels are designed for users who are experienced in 3D navigation and
prefer to have more screen space and smaller controls.  

  
 

  Mini navigation wheel   Mini view object wheel   Mini tour building wheel
  

You control the appearance of Steering Wheels using the Options dialog box.
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The following illustration shows the SteeringWheels tab in the Options dialog box. 

 
View Cube Navigation

  
In 3D views, the view cube is present in the upper-right corner of the view window by default. The
view cube is composed of a compass and a cube.  

 
 

  Compass   Cube
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To orient the view in a specific direction, you select the appropriate compass direction indicator and
drag. You can place your cursor over the compass and select and drag the model on the ground plane.
You can also orbit the model by selecting any part of the cube and dragging it. To orient the view, you
select any named face, edge, or corner of the cube. To return the view to its original position, you
select the home icon.

  
You control the appearance of the view cube in the Options dialog box. The following illustration
shows the ViewCube tab in the Options dialog box.  

  
You can also toggle the display of the view cube by selecting or clearing the ViewCube check box that
can be accessed from the User Interface drop-down on the Windows panel of the View tab.   
The following illustration shows the selected ViewCube check box. 
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Example of 3D Views
   

The following illustrations show a camera positioned in a plan view and the corresponding perspective
3D view of the model created by the camera.

 

 

 

  Plan view   Perspective 3D view
  

 

About Cameras
   

To create a 3D view, you add a camera to a project and focus the camera on the model in views such
as floor plan and elevation. After you add a camera to a project, you can move either the camera or
the view target to change the 3D view of the project. You can also set and modify the properties of 3D
views and save the views.

 
Definition of Camera

  
A camera presents a scene from a particular point of view. Camera objects simulate still-image, motion
picture, or video cameras in the real world.

 
Creating Additional 3D Views

  
You change a camera view by modifying the camera properties. You can add cameras to create new 3D
views. For example, you can produce a view inside a building model by placing the camera inside the
walls of the model. 3D views differ from each other on the basis of the actions you perform, such as
changing the position of the camera or the target point. Additionally, you can modify the far clip plane
associated with the camera to change what the 3D view displays.
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Rotating 3D Views

  
The target point defines the axis of rotation for a 3D view. You can rotate a 3D view about this axis by
modifying the camera level and its focal point. When you change the building model in a 3D view, the
changes also occur in other views. You can tile all the open views in the view window to watch the
changes simultaneously. In plan or elevations views, you can make the cameras of 3D views visible.
You can also modify camera position and target points.

 
Naming and Saving Views

  
When you first place a camera, a 3D view of the current project is opened in the Project Browser,
which is named 3D View 1. Additional camera view names increment in the Project Browser as they
are created.

  
The default 3D view is an orthographic aerial view oriented to the southeast. It is named {3D} in the
Project Browser. If this view is not present in a project, you can create it by selecting the Default 3D
option from the 3D View drop-down on the Quick Access toolbar. You can also open the default 3D
view by selecting 3D View from the 3D drop-down on the Create panel of the View tab. Once this view
is created, you can use the Quick Access toolbar icon or the 3D View tool from the ribbon to open the
view, not create a copy.

  
You open a 3D view by double-clicking the name of the view in the Project Browser. You can modify
the orientation of the default 3D view but it will revert to the default orientation the next time you
open the project. To save the changes to the default 3D view, rename the view in the Project Browser.
You can then open another default 3D view. You can duplicate the default 3D view or any 3D view. You
organize views by name so that you can manage projects with multiple 3D views.

 
Modifying 3D Views

  
You can modify 3D views by setting their properties, such as the model graphics style, view scale, far
clip offset, and crop region.

  
You can change the crop region, which defines the boundaries for the 3D views, by moving the top,
bottom, right, and left clip planes.  

 Crop region defining the boundaries for 3D perspective view
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Additionally, you can modify the eye elevation and target elevation, which are also referred to as
camera height and target point height, respectively, for 3D views.

 

  
Changes made to the orientation or position of the default 3D view are temporary
until you save the view.

 
 

Examples of Cameras and Camera Views
  

The following illustrations show a camera positioned in the plan and elevation views and how the
camera creates a 3D view from the plan and elevation views. 

 Camera positioned in the view
   

 3D view created by the camera positioned in the plan view
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 Camera positioned in the elevation view
   

 3D view created by the camera positioned in the elevation view
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Creating and Modifying Camera Views
   

You create a 3D perspective or orthographic view of a building model by adding a camera. You modify
the view by changing the camera position, target, or field of view. 

 

Procedure: Creating 3D Perspective Views
   

The following steps describe how to create a 3D perspective view.
  

1.   Open the plan, elevation, or section view in which you want to place the camera.
 
2.

 Click View tab > Create panel > 3D View drop-down > Camera.

  
3.   On the Options Bar, select the Perspective check box.
 
4.   In a plan view, on the Options Bar, set the camera level and Offset, which is set by default to the

height of the eye above the level of the view.
 Note: These options are not available in the section or elevation view.

 
5.   Place the camera and drag the target point.
 
6.

 Set the camera target.

  Note: The Project Browser contains a default name, such as 3D View 1 or 3D View 2, for the
newly created 3D perspective view. You can rename the view.

   
 

Procedure: Creating 3D Orthographic Views
   

The following steps describe how to create a 3D orthographic view.
  

1.   Open the plan, elevation, or section view.
 
2.   Click the Camera tool.
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3.   On the Options Bar:

■ Clear the Perspective check box.
■ Specify the view scale.

 
4.   In the view window:

■ Place the camera.
■ Drag the camera to a location where you want to position the camera.
■ Place the target point.
 Note: The Project Browser displays the default name of the view under 3D Views. You can
rename the view.

   
 

Procedure: Modifying Existing Camera Views
   

The following steps describe how to modify an existing camera view.
  

1.   In the Project Browser, double-click the 3D view name.
 
2.   On the Navigation Bar, click SteeringWheels.
 
3.   On the selected Steering Wheel, use the buttons to perform the required actions.

 Note: You can also navigate using the mouse wheel.
 
4.   If you are in the default 3D view, save the view to retain the modification. Changes to camera

views persist.
  

 

Guidelines for Creating and Modifying 3D Views
   

The following are some best practices for creating and modifying 3D views.
 

Guidelines
■ Place the camera far enough from the building model when placing a camera for a perspective

view so that the field of view lines show what you want to see in the view. Placing the camera
too close to the model provides severe angles that may be unrealistic or may not reveal the
perspective view. If you place the camera farther away, it will be easier to adjust the view.

■ Place a camera in a plan view carefully so that you are aware of the level you are working on
because initially the level determines the height of the camera. Careful placement reduces
the chance of unexpected results in the camera view. You can change the camera level later, if
required.

■ Use the View Control Bar tools at the bottom of the view window to edit the display properties of
a 3D view. To save system resources, keep perspective views in Hidden Line display while adjusting
them until you are ready to export images or display them to a client.

■ Right-click the view name in the Project Browser and click Show Camera to make the camera
visible in plan, elevation, and other 3D views. You can then drag the camera, target, or far
clip plane to modify the view. This is a quick method to adjust the appearance and crop for a
perspective view.

■ Save or rename the default 3D view to retain the camera position changes. If you do not do this,
your work could be lost when you close the file. Creating named orthographic views is a quick
method to provide multiple views for a design review.
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Example
  

The following illustration shows a camera placed in a plan view with field of view lines showing that
the entire building is in the view. 

 Field of view camera
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Chapter Summary
 

  
Now that you have learned how to create and manage views of your building model, you can work in
these views and present them in ways that best illustrate your design.  
In this chapter, you learned to:

■ Explore the different views displayed in the Project Browser and modify their properties.
■ Control the visibility and appearance of elements in different views.
■ Create and modify section and elevation views.
■ Create and modify 3D views.
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Chapter

8

Developing the Building Model
 
  

In this chapter, you learn more about developing your building model by including floors, ceilings,
roofs, curtain walls, and stairs and railings in your design.

 
Chapter Objectives

  
After completing this chapter, you will be able to:

■ Create and modify floors.
■ Add and modify ceilings in a building model.
■ Add and modify the roofs of a building model.
■ Add curtain walls in a building model.
■ Create stairs, add railings to the stairs, and change the properties of stairs and railings.
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Lesson: Creating and Modifying Floors
 

  
This lesson describes how to create and modify floors. You begin the lesson by learning about
floors and the steps to modify them. Next, you learn some recommended practices for creating and
modifying floors. The lesson concludes with exercises on creating and modifying floors.  
You can create flat or sloped floors at any level in your model. You can define several types of floors
and choose different materials, such as tiles, bricks, wood, steel, concrete, or ceramics, for a floor.
You can use one or more layers of these materials to create a floor that is solid concrete or a carpeted
floor over joists. Slabs can be used as a combined floor and foundation system. For example, in a
building that has floors on two levels, the slab used as a roof for the first level is the floor for the
second level.  

 3D view of a building with the ground-level floor visible and the upper-level floor hidden
 
 

Objectives
  

After completing this lesson, you will be able to:

■ Describe floors.
■ Modify floors.
■ State the recommended practices for creating and modifying floors.
■ Create and modify floors.
■ Create and modify a structural floor.
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About Floors
   

Floors are level-based elements and are essential components of a building model. You can create
floors by using the Floor tool. Several predefined floor types are available. You can also create new
floor types, such as finish material over plywood sheathing over wood joists, or finish material over
concrete over metal deck. In addition, you can edit the required floor types, save, and reuse them
within a project. Apart from editing, you can also modify a floor type and the properties of a floor.

 
Definition of Floors

  
A floor is a horizontal surface supported by a building structure. All building elements placed on a floor
are supported by the floor. To create floors, you need to first sketch their outline. Sketching involves
defining the boundaries of a floor either by selecting walls or by sketching lines. You create a floor in
the sketch mode by using the Line or Pick Walls tool on the Draw panel of the Create Floor Boundary
contextual tab. The Line tool is used to sketch a floor by drawing lines, and the Pick Walls tool is used
to select the walls to which a floor is attached. The floor sketch must form a closed loop.

  
When you add a floor, you specify its vertical position by creating it on a level. The top of a floor is
placed by default on the level where it is created, with its thickness projecting downward. In the
Instance Properties dialog box, you can specify a height offset of the top surface of the floor from the
placement level.

  
Floors have defined parameters that determine their type and behavior. The type parameters of a
floor control the structure and appearance of the floor. The instance parameters of a floor control the
vertical placement and phase of the floor.

 
Creating Sloped Floors

  
To create a sloped floor, you sketch a floor outline and specify its slope by using a slope arrow. You can
modify the slope properties of a sloped floor after sketching it by modifying the properties of the slope
arrow.   
The following illustration shows the instance properties of a slope arrow. 

 Slope arrow properties always include the level and offset of the tail of the slope arrow. If you select
Height at Tail from the Specify list, you need to specify the values for the Level at Head and Height
Offset at Head parameters. If you select Slope from the Specify list, you specify the value for the Slope
parameter. Height Offset and Slope can be negative values.
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Creating Tapered Floors

  
To create a tapered floor, you can place points or lines on the surface of a floor that are offset
vertically. You can place break lines on a floor surface by designating beams, which can be sloped,
as supports for the floor. You can edit the position of points or lines that are applied to the floor
surface by using shape editing tools. Shape editing tools, such as Add Point and Add Split Line, are
available on the Shape Editing panel of the Modify Floors contextual tab that appears when you select
a floor. These tools enable you to manipulate the surface of an existing horizontal floor by defining the
high and low points for drainage. By specifying the elevation of these points and lines, you can split
the surface into subregions that can slope independently. These commands can be used to slope a
constant thickness slab or the top surface of a slab with a variable thickness layer.

 
Structural Floors

  
A structural floor is a horizontal surface that supports gravity loads and transfers these loads to
the supporting structure. For a structural floor, you can specify the maximum or minimum loads.
Structural floors created in Autodesk® Revit® Architecture are not purely structural because you
cannot specify load properties for them. You specify the composition and internal structure of floors
based on the loads placed on the floors.

  
You place structural floors to ensure that the depth of the floor support is sufficient for the span,
based on standard codes and tables.

  
You create structural floors by selecting the Structural Floor option from the Floor drop-down on the
Build panel of the Home tab.   
The following illustration shows the Structural Floor option. 

 Floors and structural floors created in Revit Architecture are identical elements, and they have the
same properties, whether you create them by using the Floor option or the Structural Floor option.
Structural floors, such as slabs created in Revit Structure, have structural properties that can be
modified in Revit Structure but are read-only in Revit Architecture.
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Example of Floors
   

The following illustrations show different types of floors.
 

 

 

 

  Horizontal floor   Sloped floor   Tapered floor
  

 

Modifying Floors
   

You can change the structure or shape of a floor after creating it. Often, a floor has an opening for a
staircase to another level. You create the opening by editing the floor sketch. You can also place an
opening object separate from the floor but hosted by it. In addition, you can modify a floor to create a
sloped or a tapered floor.  

 Floor with an opening for a staircase
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Procedure: Creating an Opening in a Floor Sketch
   

The following steps describe how to create an opening in a floor by editing the floor sketch.
  

1.   Select a floor.
 
2.   Click Modify Floors tab > Edit panel > Edit Boundary.
 
3.   On the Draw panel, click Boundary Line > Line or Pick Walls.
 
4.   Pick or draw lines to indicate the opening boundary.
 
5.   In the view window, drag or trim any boundary lines that overlap or extend beyond another line

so that they join and form a single closed boundary loop.
 Note: The boundary loops must be closed. Also, these loops cannot overlap or cross any other
floor boundary. This is required because gaps or intersecting lines produce error messages.

 
6.   On the Floor panel, click Finish Floor to complete the opening.

   
 

Procedure: Creating a Sloped Floor
   

The following steps describe how to create a sloped floor by using a slope arrow.
  

1.   Select a floor.
 
2.   Click Modify Floors tab > Edit panel > Edit Boundary.
 
3.   On the Draw panel, click Slope Arrow > Line or Pick Lines.
 
4.   Place a slope arrow in the floor sketch so that it is parallel to the slope with its tail at one

defining point and its head at the other.
 
5.   On the Draw panel, click Properties.
 
6.   In the Instance Properties dialog box, specify values for the Height Offset at Tail and either

Height Offset at Head or Slope.
 
7.   On the Floor panel, click Finish Floor to include the slope in the floor.

   
 

Procedure: Attaching a Floor to Sloped and Nonparallel Supports
   

The following steps describe how to attach a floor to sloped and nonparallel supports.
  

1.   Select the floor.
 
2.   Click Modify Floors tab > Shape Editing panel > Pick Supports.
 
3.

 Select existing beams to define supports for the floor. The floor warps or splits based on the
elevations of the beams.

  
4.   On the Quick Access toolbar, click Modify to restore the floor appearance.
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Procedure: Creating a Variable Thickness Floor
  

1.   Select a floor.
 
2.   Click Modify Floors tab > Shape Editing panel > Add Point.
 
3.   On the Options Bar, set an offset distance for the point.
 
4.

 In the view window, click to place the point.

  
5.   On the Quick Access toolbar, click Modify to restore the floor appearance.
 
6.   Open a section view through the altered floor.
 
7.

 In the view window, select the floor to create a variable layer in a tapered floor.

  
8.   Open the Type Properties dialog box.
 
9.   In the Type Properties dialog box, for Structure, click Edit.
 
10.   In the Edit Assembly dialog box:

■ Select the layer that you want to make variable in thickness.
■ Select the Variable check box for the selected layer.
■ Click OK.
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Guidelines for Creating and Modifying Floors
   

The following are the recommended practices for creating and modifying floors.
 

Guidelines
■ Offset a floor either up or down from the level on which it is created to ensure flexibility in floor

creation. Examples of floors being offset include a mezzanine, a split-level floor plan, and a
multilevel deck. You can also create levels specifically for holding partial floors without creating
separate views for those floors until the views are required. These practices keep the Project
Browser organization simple.

■ Combine partial floor views with main floor views by using the Plan Region tool to assign different
depth properties to a portion of a plan view. This tool can be accessed from the Plan Views drop-
down on the Create panel of the View tab. Combining plan views in this way keeps the Project
Browser organization simple.

■ Create openings for pipes or ductwork in a floor by creating the basic shape of the floor and then
adding openings at required locations. This is advisable because it is easier to place separate
openings and modify them than to edit the main floor sketch repeatedly.

■ Place floors and openings at an early stage in the design process by using generic floor types as
place holders. During design development, you can examine various floor construction methods
by changing the floor type and checking the results in section views. This saves time and improves
accuracy as you do not need to edit the floor outline sketch.

■ Create a sloping floor under the toposurface, and attach the railing or the fence to the floor to
show a fence or a railing on sloping topographic site objects. You can hide the floor in elevations,
sections, and 3D views to improve the accuracy of those views.

■ Use the Add Split Line shape editing tool if you need to specify the exact location of floor tapers
or set-downs while creating a tapered floor. This ensures that the tapered floor does not warp in
unexpected ways.

■ Check the variable thickness property of appropriate layers in the floor structure when you taper
the surface of a floor. This ensures that the taper is displayed correctly in section views.

■ Pay careful attention to the floor structure, including the insulation. Create floor surface shaping
carefully for proper drainage. Exterior patios and decks can become part of rain harvesting
measures in dry climates, and floor insulation is important for energy efficiency in cold climates.
Whether or not you have access to green design analysis, paying attention to details such as floor
structure can raise the sustainability score of your building designs. Floor construction can be an
important part of sustainable design efforts for both cold climate and hot climate construction.
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Lesson: Working with Ceilings
 

  
This lesson describes how to work with ceilings in a building model. You begin the lesson by learning
about ceilings and the steps to create and modify them. Next, you learn about some recommended
practices for working with ceilings. The lesson concludes with an exercise on creating and modifying
ceilings and ceiling components.  
You use ceilings to host components such as lights and electrical equipment, smoke detectors, and
emergency lighting. Depending on the design requirements, you can create different types of ceilings,
such as grid and metal rail.  

 Grid ceiling
 
 

Objectives
  

After completing this lesson, you will be able to:

■ Describe ceilings.
■ Identify the steps to modify ceilings.
■ State the recommended practices for working with ceilings.
■ Create and modify ceilings and ceiling components.
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About Ceilings
   

You add ceilings to a building model to specify the placement of ceiling components, such as lights,
plumbing fixtures, and ventilating components. You can view ceilings and their contents in ceiling plan
views.

 
Definition of Ceilings

  
Ceilings are level-based elements that you can create in a building model. Ceilings are automatically
offset from a level. You can change the offset value of a ceiling, if required. You can create sloped
ceilings and ceilings containing complex structures.

 
Ceiling Creation Methods

  
You can create ceilings automatically or manually. You create ceilings automatically by selecting
Ceiling on the Build panel of the Home tab, and choosing a predefined ceiling type. You specify the
ceiling type while creating a ceiling. You can also modify the ceiling type any time during the design
development process. You manually create a ceiling that is specific to your design requirements by
sketching the ceiling boundaries specifying the walls to which the ceiling is to be attached.

  
You need to open the plan view to create a ceiling. Ceiling plan views are specifically used for creating
and viewing ceilings. However, you can view a ceiling in other views, such as the section and 3D views.

 
Examples of Ceilings

  
The following illustration shows the top view of a stud frame and gypsum board ceiling with a square
opening on the left. This ceiling contains round lights and a ceiling-mounted fan. The ceiling on the
right uses an acoustic tile grid with lights, air supply registers, and air return registers.  

----------------------------------------------------------------------------------------------------------------------------------------

KKMSOFT

Downloaded From : www.EasyEngineering.net

Downloaded From : www.EasyEngineering.net

www.EasyEngineering.net

http://easyengineering.net
http://easyengineering.net


52          ■         Chapter 8: Developing the Building Model

   
The following illustration shows a section view of two ceilings. The ceiling on the left contains a grid.

  

   
The following illustration shows a 3D view of a gypsum board ceiling.
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Modifying Ceilings
   

You can modify ceilings by editing their properties. A design change may specify a 4 x 2 grid after you
have placed a 2 x 2 ceiling. In such a situation, you modify the ceiling properties instead of replacing
the ceiling. 

 
Ceiling Properties

  
You can modify ceiling properties before or after you place a ceiling in a drawing by using the Instance
Properties or Type Properties dialog box. The following illustration shows the instance properties of a
ceiling. 
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The following illustration shows the type properties of a ceiling. Ceilings can have complex structures
similar to floors and roofs, and you can edit the structure by modifying the type properties.

 

 

 

  The Type Properties dialog box of a
compound ceiling

  The Edit Assembly dialog box of a compound ceiling

   
 

Procedure: Modifying a Ceiling
   

The following steps describe how to modify the instance properties or boundary sketch of a ceiling.
  

1.   Select the ceiling to modify.
 
2.   Open the Instance Properties dialog box and change the properties, as required.
 
3.   Draw lines or pick walls to modify the boundary outline sketch.
 
4.   On the Ceiling panel, click Finish Ceiling.

   
 

Procedure: Modifying a Ceiling Type Before Creating a Ceiling
   

The following steps describe how to modify a ceiling type before creating a ceiling.
  

1.   Click Home tab > Build panel > Ceiling.
 
2.   Open the Type Properties dialog box and change the properties, as required.
 
3.   Place or sketch the ceiling.
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Guidelines for Creating and Modifying Ceilings
   

While creating and modifying ceilings, you should follow certain recommended practices to enhance
your design accuracy and save time.

 
Guidelines
■ Ensure that you open the ceiling plan view for the level in which you want to place a ceiling. You

can create ceilings in a floor plan view; however, when you do this, the software displays a warning
message. Checking the current view before adding a ceiling saves time.

■ Use the Underlay property of a ceiling plan view to display windows, doors, and furniture while
placing components, such as lights and fixtures, in a ceiling. You need to do this because the view
range properties of ceiling plan views are different from floor plan views. Therefore, ceiling plans
do not display windows, doors, and furniture. Using the Underlay property increases accuracy in
placing ceiling components.

■ Place components in a ceiling grid and then align them to gridlines so that they move with the
grid, if required. You need to do this because ceiling components do not snap to gridlines. Aligning
ceiling components to gridlines increases design accuracy.
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Lesson: Adding and Modifying Roofs
 

  
This lesson describes how to add and modify the roofs of a building model. You begin the lesson by
learning about roofs and the process of sketching them. Next, you learn some recommended practices
for adding and modifying roofs. The lesson concludes with an exercise on adding and modifying roofs.  
In Revit, there are three different ways to create roofs: you can create flat, sloped, or curved roofs.
You can also combine simple roof shapes to create complex roof designs. You can place roofs in plan,
elevation, and 3D views.   
The following illustration shows roofs attached to walls and other roofs. 

 
Objectives

  
After completing this lesson, you will be able to:

■ Describe roofs.
■ Identify the steps in the process of sketching roofs.
■ State the recommended practices for adding and modifying roofs.
■ Add and modify roofs.
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About Roofs
   

Roofs are building elements, just like walls and floors. You can design any type of roof for a building
model using Revit.

 
Definition of Roofs

  
Roofs are building components that represent different types of roofs that you can create when
designing building models. You create roofs by sketching footprint outlines or extrusion edges or by
picking faces. You can modify roof properties such as outline, structural composition, and slope.

 
Roof by Footprint

  
A roof footprint is a 2D sketch of the perimeter of a roof. You draw a footprint by sketching lines or by
selecting walls to define the roof perimeter. In both cases, you specify a value to control the offset of
the roof from the walls. You create a footprint roof at the level of the plan view where the perimeter
is sketched. A sketch of a footprint must be a closed loop that represents the exterior of the roof. A
sketch can also contain other closed loops inside the perimeter that define openings in the roof. You
define the slopes of a roof by specifying the lines in a footprint as edges of sloping roof planes. You
use the Roof by Footprint tool to create the most common roofs such as hip roofs, shed roofs, gable
roofs, and flat roofs.

 
Roof by Extrusion

  
You create a roof by extrusion by sketching the profile of the top of a roof in an elevation or section
view and then extruding the roof. You use the Roof by Extrusion tool to create more complex organic
roof designs than the ones created using footprint outlines. You set the start and end points of a
roof extrusion to determine the horizontal depth of the roof. You can use a combination of straight
lines and arcs to create the roof profile. The location of the profile in the elevation view determines
the height of the roof. The sketch of a roof should be a series of connected lines or arcs that are not
closed in a loop. Revit applies the roof structure according to the type of roof.

 

  
Only footprint and extrusion methods are covered in this lesson. The third method,
roof by face, is part of massing, which is covered in the Advanced course.
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Extrusion Direction of Roofs

  
The direction in which a roof profile extrudes is known as the extrusion direction. When extruding a
roof in an elevation or a section view, you need to determine a perpendicular work plane, such as a
wall. You can extend the extrusion toward or away from the view. Extrusion directions that are upward
or toward the view are positive, and extrusion directions that are downward or away from the view
are negative.

 
Properties of Roofs

  
You can modify the instance and type properties of roofs. The instance properties you can modify
include outline, slope defining edges, slope angle, and base level. When you modify the type
properties of a roof, such as structure, the change affects all instances of the roof type. You can select
a roof or a roof sketch to edit its properties.  

 Roof sketch and instance properties
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Example of Roofs
  

The following illustration shows a building model with different roof types. 

  

 

  Flat footprint

 

  Curved extruded

 

  Sloped footprint
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Process of Sketching Roofs
   

You can sketch roofs using footprint, extrusion, and roof by face methods. 
 

Process: Sketching Roofs by Footprint
  

The following illustration shows the process of sketching roofs by footprint. 

    
The following steps describe the process of sketching roofs by footprint.

  
1.   Select roof method. Select Roof by Footprint from the Roof drop-down on the Build panel of the Home tab.
 
2.   Specify roof properties. Specify the roof instance properties in the Instance Properties dialog box. For Base Offset From

Level, you can specify a height value to vertically offset the roof deck from the level at which it is
drawn. You can select a generic or a complex roof type from the Type list or create a new type.

 
3.   Sketch roof outline. Sketch the roof area in the view window using faces of walls or drawing lines.
 
4.   Change value of roof slope. Change the value of the roof slope for individual edges using the angle symbol displayed below

each sketch line.
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Process: Sketching Roofs by Extrusion
  

The following illustration shows the process of sketching roofs by extrusion. 

    
The following steps describe the process of sketching roofs by extrusion.

  
1.   Select roof method. Select Roof by Extrusion from the Roof drop-down on the Build panel of the Home tab.
 
2.   Specify work plane. Specify a work plane for the roof in a section or elevation view. You do this using a grid, a

previously created reference plane, or a wall face.
 
3.   Specify roof properties. Specify the roof properties. You can specify Instance Properties such as Base Offset From Level

for setting a height value to vertically offset the roof deck from the level at which it is drawn. You
can select a generic or complex roof type from the Type list or create a new type.

 
4.   Sketch roof profile. Sketch the profile of the top edge of the roof in the view window by drawing lines.
 
5.   Change depth of roof extrusion. Change the depth of the roof by specifying the start and end of the extrusion.

  

----------------------------------------------------------------------------------------------------------------------------------------

KKMSOFT

Downloaded From : www.EasyEngineering.net

Downloaded From : www.EasyEngineering.net

www.EasyEngineering.net

http://easyengineering.net
http://easyengineering.net


Lesson: Adding and Modifying Roofs       ■       67

 

Guidelines for Adding and Modifying Roofs
   

The following recommended practices help you save time and prevent inaccuracies while adding and
modifying roofs.

 
Guidelines
■ Be careful about the level of the plan view in which you are working when you create a footprint

roof. You should be careful because while creating a roof on the level above or below the view,
you might not view the roof when it is finished. This could lead to mistakes and inaccuracies in the
design.

■ Pay attention to the View Range properties of the view you use to create a footprint roof. The view
range provides better control over the display of roofs in a design.

■ Plan each extruded roof ahead of time, study the requirements of the roof, create views that
point in the correct direction, and create reference planes, where appropriate. This saves time and
enhances accuracy.

■ Use the Join/Union Roof tool to create complex roof assemblies. Make multiple roofs and join
them to create the conditions that you require. Do not try to model a very complicated footprint
roof to match the exterior walls of an elaborate building outline, particularly if the walls are of
different heights. This saves time and improves accuracy.

■ Specify insulation as part of a roof structure and view sun/shadow performance in the elevation
or 3D view. Also, use external applications for energy analysis to calculate the airflow for roofing.
Roofs with proper shading or exposure of windows, insulation, and ventilation can significantly
reduce the energy costs of a building during its lifetime.

----------------------------------------------------------------------------------------------------------------------------------------

KKMSOFT

Downloaded From : www.EasyEngineering.net

Downloaded From : www.EasyEngineering.net

www.EasyEngineering.net

http://easyengineering.net
http://easyengineering.net


Lesson: Adding Stairs and Railings       ■       93

Lesson: Adding Stairs and Railings
 

  
This lesson describes how to add stairs and railings in a building model and change the properties
of stairs and railings. You begin the lesson by learning about stairs and railings. Then, you learn the
steps and some recommended practices for creating stairs and railings. The lesson concludes with an
exercise on creating and modifying stairs and railings.  
In a few simple steps, you can create straight, curved, spiral, and almost any other conceivable
configuration of stairs for a building design. Railings are freestanding elements that you add to floors
or staircases.  

 U-shaped straight stairs with a rectangular landing and attached railings
 
 

Objectives
  

After completing this lesson, you will be able to:

■ Describe stairs and railings.
■ Identify the steps to create stairs and railings.
■ State the recommended practices for creating stairs and railings.
■ Create and modify stairs and railings.
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About Stairs and Railings
   

Stairs and railings are parametric elements in Revit. These elements are easily created to suit any
design requirement and can be complemented with various railings.

 
Definition of Stairs and Railings

  
Stairs and railings are building elements. You can attach railings to stairs, ramps, and floors as
required.

  
Stairs and railings are system families. You can modify existing stair and railing types to suit your needs
and save stair and railing types in project templates.

 
Properties of Stairs

  
You create stairs by specifying a stair run or by sketching riser lines and boundary lines. When you
select the starting point of the stairs in the plan view, you can calculate the number of treads based on
the distance between the floors. You can also define the maximum riser height in the stair properties.

  
You can specify the dimensions of stairs, such as width, number of risers, and tread depth, in the Type
Properties dialog box. You can specify the Base Level, Top Level, Base Offset, and Top Offset properties
in the Instance Properties dialog box.

 
Spiral Stairs

  
You define a spiral staircase using Center-ends Arc on the Draw panel of the Create Stairs Sketch
contextual tab. When you draw spiral stairs, the spiral is limited to less than 360 degrees without an
overlap in the spiral stair runs. To create spiral stair landings, you need to sketch arc runs with the
same center and radius.

 
Multistory Stairs

  
You can set stairs to repeat vertically in a multistory building by using the Multistory Top Level
property. For multistory stairs to be accurate, all stories of a multistory building must have the same
height between the levels.
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The following illustration shows single story and multistory stairs. 

 
Railing Types

  
While sketching new stairs, you can specify the railing type to be used using Railing Type on the Tools
panel. You select the railing type from the list of available types in the Railings Type list. You can select
None if you do not need a railing for the stair or Default to use the default railing and then modify it
later. Railing Type is available only while sketching new stairs.

 
Structure of Railings

  
Railings consist of rails and balusters. Rails run horizontally, and the top rail height is usually fixed
by code. You can place additional rails below the top rail. You can modify the rails by editing rail
properties and arrangement in the Edit Rails dialog box.

  
Balusters are the vertical members in a railing that support the rails between the handrails and stair
treads. You arrange baluster families in a repeating pattern and add posts to create balusters. When
creating balusters, you define baluster properties and characteristics in the Edit Baluster Placement
dialog box. You can access the Edit Rails and Edit Baluster Placement dialog boxes from within the Type
Properties dialog box for a selected railing.

  
You do not add balusters or posts when the railings are wall mounted. 

----------------------------------------------------------------------------------------------------------------------------------------

KKMSOFT

Downloaded From : www.EasyEngineering.net

Downloaded From : www.EasyEngineering.net

www.EasyEngineering.net

http://easyengineering.net
http://easyengineering.net


96          ■         Chapter 8: Developing the Building Model

 

Example of Stairs and Railings
   

The following illustrations show stairs and railings.
 

 

   Spiral staircase with single-rail square
railing
 

  Arced and straight railings

  

 

Creating Stairs and Railings
   

You can create a staircase by sketching run outlines or by sketching boundary lines and risers for the
staircase. You can define the type of railings for stairs and modify the railing properties, if required. 

 

Procedure: Creating Stairs by Sketching Boundary Lines and Risers
   

The following steps describe how to create stairs by sketching boundary lines and risers.
  

1.   Click Home tab > Circulation panel > Stairs.
 
2.   Click Create Stairs Sketch tab > Draw panel > Boundary. Select any draw option.
 
3.

 Sketch the side boundaries, which can be single lines or multisegment combinations of straight
lines and arcs.

  Note: The boundaries do not have to be parallel. Do not connect the left and right boundary
lines.

 
4.   On the Draw panel, click Riser.
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5.

 Sketch risers between the boundary lines. The number of risers currently created and the
number of risers expected, based on the stair parameters, are displayed. This counter updates as
you place risers. Riser lines do not have to be parallel.

  Note: Building codes require that flights of stairs (between landings) have equidistant treads,
and there are strict limits on the variation in treads between stair flights. It is possible to design
illegal or dangerous stairs by sketching risers.

 
6.

 To create a landing:
■ Provide a space in the sketch with no risers.
■ After you sketch the stairs, on the Edit panel, click Split.
■ Split the boundary lines where they define the landing.

  
7.

 On the Stairs panel, click Finish Stairs.

    
 

Procedure: Specifying the Railing Type While Creating Stairs
   

The following steps describe how to specify the type of railings while creating stairs.
  

1.   Activate the Stairs tool.
 
2.   Click Create Stairs Sketch tab > Tools panel > Railing Type.
 
3.   In the Railings Type box, select a railing type. If the railing type you need is not available on the

list:
■ Quit the stairs.
■ Create the new railing type.
■ Restart the stairs creation process.
 Note: You can also create stairs using one railing type and change the railings later.

 
4.   Finish sketching the stairs.
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Guidelines for Adding Stairs and Railings
   

You can add various types of stairs and railings in your designs. The following recommended practices
help you work efficiently while adding stairs and railings.

 
Guidelines
■ You create stairs going up from the level on which you draw the sketch. To change the direction

of stairs, finish sketching the stairs, then select the stairs and click the blue flip control arrow to
switch the orientation of the stairs. This eliminates the need to re-create stairs if you inadvertently
create them in the wrong direction.

■ After creating a set of stairs, you can select the stairs and edit their boundary at any time using
Edit Sketch on the Edit panel of the Modify Stairs contextual tab. This saves time while making
changes to the stairs.

■ You can create reference planes to represent the centerline of the stairs when the stairs plan is
being designed. This improves planning during the design phase. In addition, the knowledge of the
desired width of the stairs saves time and enhances accuracy when you create U-shaped stairs to
fit inside stairwell walls.

■ Railings and stairs are system families, and therefore cannot be loaded from library files. Fences
are constructed as railings. There are extensive stair, railing, and fence types contained in sample
project files in the System Family Files folder in the Metric Library. You will save time if you open
these files and copy/paste stairs, railings, and fences into a project and modify them as needed.

■ You use the Ramp tool to create a ramp. The process of creating a ramp is similar to that of
creating stairs. You can design ramps as big as those for automobile parking lanes or as small as
those for pedestrian access with complete control over their thickness and structure. 

 
Example

  
The following illustration shows reference planes in a stairwell and the flip control arrow.
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Chapter Summary
 

  
Now you have learned how to include floors, ceilings, roofs, curtain walls, and stairs and railings in
your designs, and you can create complete building models.  
In this chapter, you learned to:

■ Create and modify floors.
■ Add and modify ceilings in a building model.
■ Add and modify the roofs of a building model.
■ Add curtain walls in a building model.
■ Create stairs, add railings to the stairs, and change the properties of stairs and railings.

----------------------------------------------------------------------------------------------------------------------------------------

KKMSOFT

Downloaded From : www.EasyEngineering.net

Downloaded From : www.EasyEngineering.net

www.EasyEngineering.net

http://easyengineering.net
http://easyengineering.net


Chapter Overview         ■        153

Chapter

10

Construction Documentation
 
  

One of the benefits of building information modeling is the ability to automate the creation of
schedules. In this chapter, you learn about schedules, how to create basic schedules and room
schedules, and how to modify the appearance of schedules and export them. You also learn about
creating legends and keynotes.

 
Chapter Objectives

  
After completing this chapter, you will be able to:

■ Create and modify schedules.
■ Create rooms and room schedules.
■ Create legends and keynotes.
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Lesson: Creating and Modifying Schedules
 

  
This lesson describes how to create and modify schedules. You begin the lesson by learning about
the types, characteristics, and properties of schedules. Next, you learn steps to export schedules
and modify the fields in a schedule. Then, you learn some recommended practices for creating and
modifying schedules. The lesson concludes with an exercise on creating and modifying schedules.  
Schedules provide information about building elements in a project, such as doors and windows that
can be exported to other applications for cost lists, estimates, and other quantity tallies. You use
schedules to display the properties of selected building elements in a tabular format. In Autodesk®
Revit® Architecture, the schedules update automatically, and therefore eliminate the errors that can
occur in a manually compiled list.  

 Window schedule
 
 

Objectives
  

After completing this lesson, you will be able to:

■ Describe the types and characteristics of schedules.
■ Describe the properties of schedules.
■ Export schedules.
■ Modify the fields that appear in schedules.
■ State the recommended practices for creating and modifying schedules.
■ Create and modify schedules.
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About Schedules
   

You can view a building model in different ways. One way is to create a schedule that displays
information about elements in a tabular format. A schedule updates automatically as the building
model develops. You can format, view, and export schedules. You can also place them on drawing
sheets to be used in documentation sets.

 
Definition of Schedules

  
A schedule is a formatted view of a building model based on the criteria you provide. It is a tabular
display of information extracted from the properties of elements in a building model. Each property of
an element is represented as a field in the schedule. Schedules can list every instance of a particular
type of element in different rows or condense information about multiple instances of an element into
a single row.

 
Types of Schedules

  
You can create three types of schedules using the Schedule/Quantities tool from the Schedules drop-
down on the Create panel of the View tab. The three types of schedules are component schedules,
multi-category schedules, and key schedules. You can also create specialized schedules from the
Schedules drop-down: material takeoffs, drawing lists, note blocks, and view lists.    
The following table describes various Schedule/Quantities types.

 
  
Schedule/Quantities
Type

  
Description

  Component   Lists the selected component properties in a tabular format. For example,
you can create a door schedule that lists the properties of doors, such
as dimensions, finish, fire rating, and cost. Component schedules can be
instance or type schedules. Instance schedules list each component as a
separate line item, whereas type schedules group components of the same
type into a single line item.

  Multi-category   Lists the components that hold shared parameters. Shared parameters
span more than one project. The available fields for this type of schedule
include the shared parameters.
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Schedule/Quantities
Type

  
Description

  Key   Lists the keys that you define for elements that consist of multiple items
with the same characteristics. The keys act as a grouping mechanism,
like style definitions. Key schedules are automatically populated with
information about the element properties in the schedule fields. For
example, a room schedule might have fields for floor finish and wall
finish. Instead of manually entering the information for each room in the
schedule, you can define keys that fill in the information according to a
room type.
  You define key schedules according to project specifications. When you
define a key, it becomes part of the instance properties of the scheduled
element. If you display the properties of that element, you see the new
key name. When you apply a value to the key, the attributes of the key are
applied to the element.

  
 

Material Takeoffs
  

A material takeoff is a specific type of component schedule. It lists the subcomponents or materials
of any Revit family. Material takeoffs have all the functionality and characteristics of other schedules.
They help you display details of the assembly of a component. Any material that is used in an element
within Revit can be scheduled.

 
Drawing Lists

  
A drawing list is a schedule of all drawing sheets in a project. It functions as a table of contents for the
project and is typically placed on the first sheet of a documentation set.

 
Note Blocks

  
Note blocks are schedules that list the instances of annotations that you apply by using the Symbol
tool on the Detail panel of the Annotate tab. Note blocks are useful for listing notes that are applied to
elements in a project. For example, you can provide building descriptions for walls by attaching a note
to each wall.

 
View Lists

  
A view list is a schedule of all views that show view parameters. You use view parameters for grouping
and filtering the Project Browser organization. You can view and modify various view parameters for
multiple views at a time.

 
Keynote Legends

  
A keynote parameter is available for all model elements, detail components, and materials. Keynote
legends group common types of keynotes. Keynote legends can be placed on multiple sheet views.
You create keynote legends using the Legends drop-down on the Create panel of the View tab.
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Revision Schedules

  
Revision schedules are included with most Revit titleblocks. After you create a drawing sheet with a
default titleblock, you can begin recording revision information on that sheet. You can add a revision
schedule to a custom titleblock.

 

  
Revision schedules are part of titleblocks and will be covered in detail in that lesson.

 
Schedule Management

  
After you create a schedule, you can perform various operations on it, such as viewing and updating
the schedule.

  
When you create a schedule, it is added to the Project Browser listing. You can display the schedule in
the view window by double-clicking the schedule name. You can also add the schedule to a drawing
sheet by dragging the schedule to the drawing sheet in the view window.

  
A schedule is a view of the model that updates automatically when you make changes to those parts
of the project that affect it. For example, if you move a wall, the floor area of the room in the room
schedule updates accordingly. Schedules are associated with an entire project, including the building
model. Therefore, when you change the properties of building components in a project, the associated
schedule is also updated. For example, you can select a door in a project and change its manufacturer
property. As a result, the door schedule updates to show this change. You can also edit a property of a
building model by selecting the field corresponding to the property in the schedule and entering a new
value for the property. Consequently, the schedule and the element type change. 

 
Example of Schedules

  
The following illustration shows a wall schedule.
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About Schedule Properties
   

Schedules contain a list of fields that display element properties, such as the areas of rooms or the
levels of doors. The properties of a schedule include the fields to be included, the sequence of the
fields, and the way the fields are presented.

  
You define the properties of schedules by using the tabs in the Schedule Properties dialog box. Based
on project requirements, you can add, filter, sort, format, and change the appearance of the fields for
properties in a schedule.

 
Definition of Schedule Properties

  
Schedule properties define the structure and presentation of a schedule. These properties help you
modify the information types that you want to include in a schedule and the appearance of that
information.

 
Schedule Properties Tabs

  
You use the five tabs available in the Schedule Properties dialog box to control the display of schedule
views and the content contained in a schedule.   
The following illustration shows the Schedule Properties dialog box.
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The following table describes the functions of the tabs in the Schedule Properties dialog box.

 
  
Tab

  
Functions

  Fields   Places parameters as fields in a schedule and sets the order in which the
fields are displayed. You use the Fields tab to add user-input and calculated
fields to a schedule. Material, finish, and door mark are examples of user-
input fields. Area and cost are examples of calculated fields.

  Filter   Controls the display of elements in single and multi-category schedules,
view lists, drawing lists, and note blocks.

  Sorting/Grouping   Sorts and groups the rows of a schedule. You can sort a schedule based on
a field, for example, sorting by the cost of doors. Use grouping to group
rows based on the element type. For example, you can show the total cost
of wooden doors and glass doors separately. You can also use this tab to
add blank lines between groups and group totals.

  Formatting   Controls the formatting, such as column headings, text alignment, and
orientation, of the schedule view and the way numerical data is displayed.
For example, you can specify the number of decimal places in a numerical
field.

  Appearance   Controls the appearance of a schedule on a drawing sheet. For example,
you can modify the appearance of a schedule by changing the font types
and sizes and hiding the schedule title and column headers.

   
 

Example of Schedule Properties
  

The following illustration shows a wall schedule displaying the wall type and dimensions.
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Exporting Schedules
   

You can export a schedule to spreadsheet applications. When you export a schedule, you save it as
a delimited text file so that it can be opened in other applications. If you repeatedly export schedule
information to the same file location, you can update the spreadsheet as desired while building a
project. 

 

Procedure: Exporting Schedules
   

The following steps describe how to export schedules.
  

1.   In the Project Browser, under Schedules/Quantities, open the schedule.
 
2.   On the application menu, click Export > Reports > Schedule.
 
3.   In the Export Schedule dialog box, specify a name and directory for the schedule and click Save.
 
4.   In the Export Schedule dialog box, under Schedule Appearance, specify the display options for

the schedule in a spreadsheet.
 
5.   Under Output options, specify values of the parameters for the text file. The text file can be

opened in a spreadsheet application.
  

 

Modifying Schedule Fields
   

You can add new fields to a schedule using the Add Parameter option. You can also modify the existing
fields in a schedule. For example, you may need to change a schedule from an instance list to a type
list, or calculate totals of the cost information. 

 

Procedure: Modifying Fields in Schedules
   

The following steps describe how to modify the fields in a schedule.
  

1.   In the Project Browser, under Schedules/Quantities, open the schedule.
 
2.   In the Project Browser, right-click the schedule view. Click Properties.
 
3.   In the Instance Properties dialog box, under Other, for Fields, click Edit.
 
4.   In the Schedule Properties dialog box, on the Fields tab, add fields, create custom fields,

calculate a value based on other fields, or change the order of fields.
 Note: You can specify the calculation criteria in the Calculated Value dialog box.
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Guidelines for Creating and Modifying Schedules
   

The following guidelines help you effectively create and modify schedules.
 

Guidelines
■ Create schedules that display only important or critical fields so that the schedules are easy to

understand. Use the Hidden Field option on the Formatting tab to hide the fields that you want to
keep available but not show in the schedule view.

■ Use headers, footers, and blank lines to identify and separate groups of similar information in a
schedule to improve readability. You can create these headers, footers, and blank lines using the
Sorting/Grouping tab in the Schedule Properties dialog box.

■ Click Show repeatedly in the Show Elements in View dialog box to open all the model views that
display the element selected in the schedule table. This helps you easily check and modify the
selected element in all views.
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Lesson: Creating Rooms and Room Schedules
 

  
This lesson describes how to create rooms and room schedules. You begin the lesson by learning about
rooms and room schedules. Next, you learn the steps to add a room tag and modify room area and
volume. Then, you learn about material takeoffs and some recommended practices for creating rooms
and room schedules. The lesson concludes with an exercise on creating rooms and a room schedule.  
You can create rooms using the Room tool or by placing the rooms from a room schedule. You create
room schedules to display the properties of room elements in a tabular format.

  
You can create and use material takeoffs to display the properties of the materials used in a room
element. A material takeoff also provides the cost and quantity estimation of the material used in a
building model.  

 

   Room schedule   Material takeoff schedule
  
 

Objectives
  

After completing this lesson, you will be able to:

■ Describe rooms.
■ Describe room schedules.
■ Add room tags.
■ Modify room area and volume.
■ Describe material takeoffs.
■ State the recommended practices for creating rooms and room schedules.
■ Create rooms and a room schedule.
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About Rooms
   

You add rooms to specify information about user-defined or automatically calculated spaces in a
building design. You create rooms using the Room tool on the Room & Area panel of the Home tab. In
addition, you can create new rooms or place unallocated rooms using a room schedule.

 
Definition of Rooms

  
Rooms are building elements just like walls, doors, and windows. You associate a room element with a
bound space in a plan or a reflected ceiling plan view. The space in a room is bounded when the space
consists of either three or more walls or three or more separation lines.

 
Room Bounding Elements

   
The following elements and their types are specified as bounding elements for room area and volume
calculations:

 
■ Curtain, standard, in-place, and face-based walls
■ Standard, in-place, and face-based roofs
■ Standard, in-place, and face-based floors
■ Standard, in-place, and face-based ceilings
■ Architectural columns
■ Curtain systems
■ Room separation lines

 
Room Bounding Walls

  
You can specify the walls of a room as bounding or nonbounding by modifying the wall properties.
When you specify that a wall is nonbounding, Revit does not use it to calculate the area or volume
of the room or any adjacent rooms. For example, you may want to define toilet partitions as
nonbounding because they are not usually included in room calculations.

  
You change a wall to a bounding wall for a room by selecting the Room Bounding Instance parameter
check box for the wall. Similarly, you can clear the check box to make a wall nonbounding for a room.

 
Room Separation Lines

  
Room separation lines are lines that define the area of rooms in plan, 3D, and camera views. The
defined area has all the functionality associated with rooms. For example, you can apply room color or
create room schedules with an area designated by separation lines. To define rooms with separation
lines, you select Room Separation Line from the Room drop-down on the Room & Area panel of the
Home tab. 
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Example of Rooms
   

The following illustrations show rooms highlighted in the plan and section views and room tags in a
plan view.

 

 
    A room in the plan view

divided by a separation line

  A room highlighted when
the cursor moves over it

  A room highlighted when selected

    

 Rooms visible after tags are placed in a section view
   

 Room tags in a plan view
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About Room Schedules
   

As an aid to the initial design phase, you can add rooms to a schedule before you define walls or place
rooms in a plan view. You can then place the predefined rooms from the room schedule at a later
stage in the project.

 
Definition of Room Schedules

  
A room schedule is a type of component schedule. It is a tabular view that represents the data
specific to various room elements used in a building model. You extract building model data from the
properties of room elements.

  
Room schedules and rooms are associated; the fields in a room schedule are properties of the rooms.
If you modify field values in a schedule, the corresponding property values are updated for the room.

 
Room Tags

  
Room tags are view-specific components that are associated with room elements. You can include
tags while placing rooms. You use the Tag Room tool on the Room & Area panel of the Home tab to
place tags in existing rooms. You can place and display room tags in floor plan, reflected ceiling plan,
and section views. A standard room tag comprises a room name and a number label. You can also
display area, volume, and other parameters in a room tag.   
The following illustration shows rooms with room tags. 

  
By default, room tags orient horizontally or vertically. You can set the orientation of room tags to
Model. This allows you to rotate tags or align them to nonorthogonal walls. You can use the Tag All
Not Tagged tool to place room tags in all rooms in a view at once.   
The following illustration shows rooms with tags aligned to nonorthogonal walls. 
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Rooms and Room Tags

  
A room element can exist without an associated room tag. However, a room tag element must have
an associated room. There is a one-to-one relationship between room tags and rooms. If a room tag
already exists in a specific area of a view, any new tag in that area is associated with the same room. If
you delete a room tag, the associated room is not deleted from the project. The data associated with
the room, such as the room area or color continues to exist because the room is still in the project.

 
Room Schedules and Room Tags

  
If you delete a room from a room schedule, the corresponding room tag is also deleted. However,
when you delete a room tag in a view, the room persists.

  
When you update values in a room schedule, the corresponding label values of associated room tags
are also updated. For example, when you change the room name in a schedule, the room tag name
label displays the modified room name.

  
However, when you move a room element that has been tagged from one bounded space to another,
Revit issues the following warning with the option to move the room tag with the room.  
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Creating Rooms

  
You create rooms by creating a new row in a room schedule or by placing a room element in a space
with a specific boundary. When you create a new row in a room schedule, the room is created without
an associated room tag. You need to place a room tag in a bounded space to populate the fields for
the area, perimeter, and level in the room schedule. If the space defined as a room is bounded by
walls, the room area is calculated from the inside face of the walls.    
The following illustrations show reference lines of a room that identify the rough extent and interior
area of a room that is used for area calculations.

 

    Reference lines   Room area selected
   
 

Example of Room Schedules
  

The following illustration shows a room schedule with room properties.
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Adding Room Tags
   

When you add room tags, you can change their orientation and specify whether they include leader
lines.   
The following illustration shows a vertical room tag. 

   
The following illustration shows a room tag with a leader line. 
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Procedure: Adding Room Tags
   

The following steps describe how to add a room tag.
  

1.   Open the view in which you want to place the tag.
 
2.   Click Home tab > Room & Area panel > Tag drop-down > Tag Room.

 Note: Untagged rooms become visible if already placed in a view.
 
3.   On the Options Bar:

■ Select the Leader check box to include a leader line with the room tag, if required.
■ Set the orientation to Horizontal, Vertical, or Model.

 
4.   Click in an enclosed area of the view to place the room tag.
 
5.   Press SPACEBAR to orient the tag.

  

 

Modifying Room Area and Volume
   

The area of rooms is calculated by default in Revit. You enable the calculation of room volume by
using the Area and Volumes radio button in the Area and Volume Computations dialog box. The dialog
box can be accessed by selecting Area and Volume Computations from the Room & Area panel drop-
down of the Home tab.

  
You can modify the area and volume of a room by modifying the room boundary locations and
changing the room bounding properties of surrounding walls or columns. You can also specify the
upper limit and offset value for a room. 

 

Procedure: Modifying Room Area and Volume
   

The following steps describe how to modify room area and volume.
  

1.   Open a plan, elevation, or section view of the room you wish to change.
 
2.   Move a room bounding wall or room separation line. This updates the area values of the

associated room or rooms.
 
3.   Select a room component.
 
4.   Open the Instance Properties dialog box for the room.
 
5.   In the Instance Properties dialog box, under Constraints Parameters, change the Upper Limit,

Upper Limit Offset, or Base Offset values for the room.
 The volume value updates if Compute Room Volumes is selected in the Room and Area Settings
dialog box.
 Note: To make room area or volume values visible, you need to load Room Tags with labels that
display the area or volume values.
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About Material Takeoffs
   

Material takeoffs are used to simplify the tracking of material quantities in cost estimates. You can also
use material takeoffs to calculate detailed material quantities based on the properties of materials
used in different building elements. You can use information about material quantities in sustainable
design analysis.

 
Definition of Material Takeoffs

  
A material takeoff is a type of a component schedule. It presents a detailed list of material quantities in
a table.

  
All tools and methods that are used for component schedules apply to material takeoffs. You can
export a material takeoff to an external database such as a spreadsheet application.

 
Material Takeoff and Building Elements

  
A material takeoff updates automatically when you change the material properties of building
elements. You can modify building elements after extracting material quantity data from them. 

 
Example of Material Takeoff

  
The following illustration shows a material takeoff with material name and cost of walls. 
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Guidelines for Creating Rooms and Room Schedules
   

The following recommended practices help you save time and prevent errors while creating rooms
and room schedules.

 
Guidelines
■ You can create room schedules based on common room types used by your company and add

these schedules to project templates. This saves time while defining rooms and room types
because your team members can select room names or designations from a predefined list.

■ You can create separate plan views for walls and rooms so that you can place appropriate
annotations easily.

■ You can place rooms without room tags and then place tags at the start of the annotation phase of
the project. This provides better workflow during the design development phase without any loss
of information.

■ Room objects hold energy requirement and consumption information when processed in Revit
MEP, or if your project is submitted to sustainable design analysis. Proper management of rooms
will enable you to track and report information that is not readily available any other way.
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Lesson: Creating Legends and Keynotes
 

  
This lesson describes how to create legends and keynotes and add them to sheets. You begin the
lesson by learning about legends and the steps to control legend visibility. Then, you learn about
keynoting, steps to link keynote files and add keynotes, and some recommended practices for
creating legends and adding keynotes. The lesson concludes with an exercise on creating legends and
keynotes.  
You use legends to easily identify the components, annotations, and symbols used in a project
and accurately interpret a building design. You use keynotes to streamline the process of manually
annotating the construction documents in a project.  

 Legend displaying different types of doors and door symbols
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 Plan view with text window keynotes
 
 

Objectives
  

After completing this lesson, you will be able to:

■ Describe legends.
■ Control legend visibility.
■ Describe keynoting.
■ Link keynote files and add keynotes.
■ State the recommended practices for creating legends and adding keynotes.
■ Create legends and keynotes.
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About Legends
   

You use legends as references to interpret the graphic displays of building components or annotations.
 

Definition of Legends
  

A legend is a view that contains tabular representations of building components or annotations along
with information related to the symbols. Any element that can be placed in drafting views, such as
detail lines, text, dimensions, tags, symbols, and filled regions, can be placed in a legend.

  
Adding legends to drawing sheets helps explain the abstract and condensed information that appears
on views such as plans or sections in the documentation of a project. You can use the same legend on
multiple drawing sheets.

 

  
A drawing sheet is a view to which you add model views.

 
Types of Legends

  
There are various types of legends that you can create and use.    
The following table describes some of the commonly used legends.

 
  
Type

  
Description

  Annotation
Symbol

  Displays symbols for 2D components such as section heads, level heads, spot
elevations, and tags. Each symbol has a related text that describes the symbol.

  Model Symbol   Displays symbols for 3D components such as electrical fixtures, plumbing
fixtures, mechanical equipment, site objects, doors, windows, and ceiling
types. Each symbol has related text that describes the symbol.

  Line Styles   Displays a view or table of selected line styles along with related text that
describes the line styles. Fire rating lines, property lines, setback lines, electric
wiring, plumbing, utilities, and center lines are some examples of line styles
displayed on legends.

  Material   Displays a sample of a cut or surface pattern along with related text that
describes the material associated with that pattern.

  Phasing   Displays sections of walls shown with selected graphic overrides along with
related text.
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Legend Components

  
The various building component symbols that you can add to a legend view are called legend
components. Examples of legend components are types of walls, ceilings, doors, floors, and furniture.
You can add these components to a legend view by using the Legend Component tool.

 
Legend Tools

  
You use annotation tools to add information to the legend components in a legend view. Text and
Dimension are two commonly used annotation tools. Using the Text tool, you can specify the name or
any other information for a legend component. Using the Dimension tool, you can add dimensions to a
legend component to specify its size and the distance between two points within the component.

  
You cannot add dimensions to system families or to host components such as walls, ceilings, and floors
in legends. 

 
Example of Legends

  
The following illustrations show a casework legend and a door legend added to a drawing sheet. 

 Casework legend
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 Door legend
 
 

Controlling Legend Visibility
   

You can control the visibility of subcategories of legend components to highlight specific information
that may be required in a legend view.  
You create a legend view for a specific purpose by controlling the visibility and appearance of the
legend components in the view. You control visibility by toggling on or off the visibility of the desired
categories of the component in the Visibility/Graphic Overrides dialog box.

  
You can also modify line weights, line colors, line patterns, and materials of the component symbols
by using the Object Styles option in the Visibility/Graphic Overrides dialog box. Changes made using
the Object Styles option affect all views. 
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Example of Controlling Legend Visibility
   

The following illustration shows the appearance of legend components controlled in a legend view.
Notice the change in the appearance of the window components when you turn off the visibility for all
the window subcategories except Glass.

 

    Before turning off visibility of
subcategories

  After turning off visibility of subcategories

   
 

Procedure: Controlling Legend Visibility
   

The following steps describe how to control the visibility of legend component subcategories.
  

1.   Open the legend view that you need to modify.
 
2.   Open the Visibility/Graphic Overrides dialog box.
 
3.   In the Visibility/Graphic Overrides dialog box, Model Categories tab, under Visibility, expand the

legend component category for which you want to control visibility.
 Tip: Click Expand All to expand all the categories simultaneously.

 
4.   Clear the check boxes corresponding to the subcategories under a category for which you want

to turn off visibility.
 Tip: To turn off the visibility of all the subcategories under a category, clear the check box
corresponding to that category.

  

 

About Keynoting
   

A keynote helps provide extra information or special instructions about a building component.
Keynoting helps you save time spent on documenting and coordinating the components used in a
building project.

 
Definition of Keynoting

  
Keynoting is a method of annotating different types of elements, materials, and user-defined
components used in a building project. You add keynotes to model views of a building design.
Keynotes are standardized notes that are controlled through an external file. 
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Types of Keynotes
   

The following table explains the three types of keynotes.
 

  
Type

  
Description

  Element   Annotates building elements. When you add an Element keynote to a
model view, it is attached to a building element. The keynote links to an
external file that holds element category information coded according to
specified industry standards or custom specifications.

  Material   Annotates building materials. When you add a Material keynote to a
model view, it is attached to a building material. You specify the material
designation, which then appears on all keynotes attached to the same
material in other components.

  User   Annotates user-defined components. When you add a User keynote to a
model view, it is attached to the component to which you assign it.

  
 

Keynote Legends
  

You generate a keynote legend to list and explain the keynotes that you add to the plan view of
a building. Using a keynote legend, you can easily locate all the instances of a particular keynote
in a project. The keynotes in a keynote legend need to be from the same keynote database. This
ensures that when you modify a keynote in a project, all other instances of the keynote are updated
throughout the project.

 

  
When you add or delete keynotes, you need to manually add or delete the keynote
references in the keynote legend or generate a new legend.
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Example of Keynoting
  

The following illustrations show various instances of keynotes used in a project.
  

 Text keynotes attached to building elements
   

 

 

  Numeric keynote being placed on a
concrete wall

  Text and numeric keynotes on two walls of the same type
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Linking Keynote Files and Adding Keynotes
   

Before you can add keynotes to a model view, you need to store the keynoting data in a keynote
source file. Using the keynote tools, you link the keynote source file to a project file and then add
keynotes to model views. The keynotes that you add are numbered according to one of two keynote
numbering methods.

 
Keynote Source Files

  
A keynote source file, called a keynote table, stores keynoting data in an external tab delimited text
file. You modify the files using a text editor and not from within the software. In Revit, keynote source
files are provided in the Imperial or Metric Library folders. You can use these files or create your own.

 

  
A tab delimited text file is a file with text format that uses tab characters as
separators between fields.

  
You link a keynote table to a project using the Keynoting Settings dialog box. In this dialog box, you
specify the path for the keynote table and select the path type. You also specify the required keynote
numbering method. You access the dialog box using Keynoting Settings on the Tag panel drop-down of
the Annotate tab.   
The following illustration shows a keynote source file. 

 
Keynote Numbering Methods

  
You can number keynotes by keynote or by sheet. Numbering by keynote lists keynotes sequentially
based on the order in which they are added to a project. Numbering by sheet lists keynotes
sequentially based on the order in which they are added to a sheet.

 

  
The attribute to be displayed inside a sheet keynote is determined when you place
the view on a sheet, not at the time of insertion.
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Chapter Summary
 

  
Now that you know how to create and modify the appearance of schedules, you can create unique
schedules for the various parts of your building projects.  
In this chapter, you learned to:

■ Create and modify schedules.
■ Create rooms and room schedules.
■ Create legends and keynotes.
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Chapter

11

Presenting the Building Model
 
  

With Autodesk® Revit® Architecture, you can present your designs in different ways. In this chapter,
you learn how to create drawing sheets, add views and titleblocks to those sheets, and create
revisions. You also learn how to create renderings, walkthroughs, and shadow studies of a model.

 
Chapter Objectives

  
After completing this chapter, you will be able to:

■ Create, modify, and specify print options for drawing sheets.
■ Add and update titleblocks and edit titleblock families.
■ Create revisions and then update the information in a revision table.
■ Create renderings for building models.
■ Create and export a walkthrough of a building model.
■ Use sun and shadow settings in a building model.
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Lesson: Working with Drawing Sheets
 

  
This lesson describes how to create and modify drawing sheets. It also describes how to specify
options for printing drawing sheets. You begin the lesson by learning about drawing sheets and the
process of previewing and printing sheets and views. Next, you learn some recommended practices
for working with drawing sheets. The lesson concludes with an exercise on creating, modifying, and
specifying print options for drawing sheets.  
Drawing sheets are used as construction documents. You can print drawing sheets to paper or
electronic files to deliver document sets to clients, collaborators, or government organizations.  

 Drawing sheet
 
 

Objectives
  

After completing this lesson, you will be able to:

■ Describe drawing sheets.
■ Identify the steps in the process of previewing and printing sheets and views.
■ State the recommended practices for working with drawing sheets.
■ Create, modify, and specify print options for drawing sheets.
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About Drawing Sheets
   

Revit enables you to create drawing sheets to hold model views. You can use these sheets to create
document sets that can also be printed. You can place any model view on a drawing sheet, specify the
scale of the view, and add annotations to the sheet.

 
Definition of Drawing Sheets

  
Drawing sheets are project views on which you place building model views, such as plans, elevations,
sections, 3D views, schedules, and legends. Drawing sheet views are listed under Sheets in the Project
Browser.  

 Drawing sheets in the Project Browser
   

Views on a drawing sheet are instances of the views in the Project Browser. When you modify a view
on a drawing sheet, the changes are automatically applied to the original view.

  
If a drawing sheet does not exist in the Project Browser, then create a new drawing sheet and drag a
view from the Project Browser to the sheet.

 
Viewport Properties

  
A viewport is a rectangular boundary around a view placed on a drawing sheet. Each viewport has
an identifying title below the rectangular boundary. You can align the view titles when you place the
viewport in a drawing sheet by dragging the view titles to an appropriate position. The view titles stay
aligned with the viewport when the viewport size changes. You can control the display of viewport
titles and create viewport types without titles.

  
In addition to moving a viewport title, you can set the viewport type properties of the title, such as
horizontal line weight, pattern, and color. You can also modify viewport instance properties to change
the appearance of a view in a drawing sheet. 
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The following table describes the viewport instance properties you can modify.

 
  
Property

  
Description

  Rotation on Sheet   Rotates a view by 90 degrees either in the clockwise or counterclockwise
direction in a drawing sheet.

  View Scale   Specifies the scale or appearance of the view in a drawing sheet.

  Detail Level   Controls the level of detail in the model view.

  Detail Number   Controls the number inside the view title bubble.

  Model Graphics Style   Specifies the display style of a view to hidden line, wireframe, shading, or
shading with edges.

  Underlay   Controls the display of an underlay in a plan view.

  View Name   Controls the name of the model view in the Project Browser.

  Title on Sheet   Controls the name of the viewport that appears on the viewport title bar.
  
 

Activating and Deactivating Viewports
  

You can activate a viewport placed on a drawing sheet and work on the building model in that view
while the drawing sheet is inactive and visible in the background. Activating a viewport is necessary
to modify a view directly from the drawing sheet. You can activate a viewport by selecting it and using
Activate View on the Sheet Composition panel of the View tab. You can also activate a view from the
viewport shortcut menu.

  
You can activate only one view at a time in a drawing sheet. To deactivate an active view after making
the required changes, you can use Deactivate View on the Sheet Composition panel of the View tab.
You can also deactivate a view from the viewport shortcut menu. 
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Example of Drawing Sheets
   

The following illustrations show drawing sheets.
 

    Drawing sheet showing the Ground Floor
plan view

  Drawing sheet showing the Reflected Ceiling plan view

    

 Drawing sheet showing the viewport selected in the plan view
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Process of Previewing and Printing Sheets and Views
   

You can print drawing sheets or model views, if required. For printing a sheet or a view, you need to
select a printer and create a print setup. You can preview a drawing sheet or a view before printing it.
You can also create a sheet or view list so you can print multiple sheets or views. 

 
Process: Previewing and Printing Sheets and Views

  
The following illustration shows the process of previewing and printing sheets and views. 

    
The following steps describe the process of previewing and printing sheets and views.

  
1.   Open the Print dialog box. To open the Print dialog box, on the application menu, click Print > Print.
 
2.   Select an available printer. You can select a stand-alone or a networked printer. Specify the properties of the printer, such

as paper size, orientation, and print quality. Some electronic output formats are also listed as
printers in the printer list.

 
3.   Specify the print settings. Specify settings, such as zoom and hidden lines, in the Print Setup dialog box. Use these settings

to highlight specific aspects of the building model.
 
4.   Preview or print the sheet. Preview the sheet after specifying the print range as the current window or the visible area of

the current window. You can also specify a selection of views or sheets to print using the View/
Sheet Set dialog box. Then, print the selected sheet or view. You can also save the print setup to
be used later in the project.
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Guidelines for Working with Drawing Sheets
   

The following recommended practices help you effectively work with drawing sheets in a project.
 

Guidelines
■ Create and carefully name several copies of views for different design and documentation

purposes, for example, Ground Floor Furniture Plan and Ground Floor Electrical Plan. Do this
because you can place each view, other than legends, only once in a sheet set. Moreover, a
viewport name on a sheet can be different from the view name in the Project Browser. Creating
and meaningfully naming views enables your project team members to easily locate design views
both on drawing sheets and in the Project Browser.

■ Create viewport types that do not display the title or extension line, or use custom linetypes.
For example, if you place a 3D view or a rendered image on a sheet as an illustration, the view
does not typically need a detail number; therefore, you set that viewport type not to show a title
symbol. Controlling the title status enables you to quickly build complex pages.

■ Create sheet views without titleblocks by deleting the titleblock after creating the sheet.
Titleblocks are standard parts of drawing sheets. They define the sheet size and hold borders,
company logo, and other information in the sheet. Titleblocks are created as separate family files
and loaded into projects or project templates. Sheet views without titleblocks can hold illustration
views for printing or exporting to image formats, which will expand your design output.

■ Create drawing sheets in your company project templates and place views on drawing sheets at
an early stage in a project. The drawing sheets and viewports update automatically as the model
develops, and you can print sheets at any time. Predefined sheet sets in project files save time and
promote design accuracy.

■ Save multi-page print setups as part of project templates. These setups can be calibrated to
different project stages. For example, when a project is in a design development stage, the concept
design setup might only print 3D views. Using print setups saves time and reduces waste. 

 
Example

  
The following illustration shows a sheet view with an untitled viewport; using this viewport enables
you to quickly build complex pages. 
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The following illustration shows a sheet view without titleblocks; this sheet view enables you to
expand your design output. 
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Lesson: Creating Renderings
 

  
This lesson describes how to create renderings for building models. You begin the lesson by learning
about renderings and the settings for creating renderings. Then, you learn some recommended
practices for creating renderings. The lesson concludes with an exercise on creating a rendering.  
Renderings simulate the real-life view of a building model by generating photorealistic images of
its interior and exterior areas. You can use these photorealistic images for marketing and making
presentations to clients.   
The following illustration shows a rendered 3D view of a building model. 

 
Objectives

  
After completing this lesson, you will be able to:

■ Describe renderings.
■ Identify the settings for creating renderings.
■ State the recommended practices for creating renderings.
■ Create a rendering.

----------------------------------------------------------------------------------------------------------------------------------------

KKMSOFT

Downloaded From : www.EasyEngineering.net

Downloaded From : www.EasyEngineering.net

www.EasyEngineering.net

http://easyengineering.net
http://easyengineering.net


Lesson: Creating Renderings       ■       237

 

About Renderings
   

Renderings help you visualize the true perspective and beauty of a building model. They create
a lighting environment that reflects the location, materials, and conditions of a building model in
realistic colors and textures. To render a building model, you first need to create a 3D view. Then, you
can set up the 3D view by placing the camera and target, setting the resolution, or changing the crop
region size.

 
Definition of Rendering

  
Rendering is the process of generating a real-life image of a building model. Rendering uses the
raytracing technique in which the rendering engine in the software analyzes the effect of lights and
shadows on a building model and creates a pixel-by-pixel display of the complete or partial building
model.

  
Rendering helps you create realistic images by adding effects such as artificial and natural lighting,
skies with clouds, and plants and people to the rendered image. You can create low-resolution or
high-resolution renderings, as required. The time taken by the rendering process depends on the
complexity, size, and resolution of the image.

 
Lighting

  
Lighting shows the physical features of a building design and helps convey the design intent. In the
absence of lighting, rendering generates a black image. Lighting effects, such as skylight, light reflected
from the ground, and light reflected off surfaces, vary between the exterior and interior areas of a
building.

  
While rendering a building model, you can use interior lighting, exterior lighting, or both to illuminate
the building. For interior lighting, you can add and group lighting fixtures, turn on or off individual
lighting fixtures or light groups, and adjust their intensity, as required. You need to specify the location,
date, and time of the day for exterior lighting to achieve a realistic representation of sunlight on the
building.

  
You can use overhead lighting when you want to show strong shadows in the rendered image. You can
use sideways lighting to give the building model a more dramatic look by enhancing its textures and
colors. For example, you can show the difference in the appearance of a house at noon in natural light
and at dusk with illuminating floodlights. 
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The following table describes the types of lighting.

 
  
Type of Lighting

  
Description

  Default lights or
headlights

  Provide illumination for shaded views to prevent a building model from
appearing completely black. You cannot move or see headlights because they
appear only in the form of rays of light. Headlights do not affect rendering.

  Sunlight   Provides illumination to create the exterior rendering of a building model.
Sunlight can be used to create the daylight exterior renderings easily.

  Artificial lights   Provide more lighting effects than those using only sunlight. Artificial lights
take time to set up and render. You can use artificial lights in combination with
sunlight to create indoor renderings of a building model.

  
 

Raytracing
  

Raytracing is the process of tracing the light rays backward from the eye of the viewer to the source
of light and determining how the rays are affected as they travel from the source to the eye. This
information is used to calculate rendering properties, such as brightness, transparency, and reflectivity
of each building model component. You can also calculate the properties for each pixel, objects in the
view, and the light sources from the eye of the viewer. Raytracing determines the color and intensity
of the pixels that create an image on the screen. Therefore, when an image is raytraced, you can
accurately and clearly see the effect of lighting on the building model. 

 

Rendering Process Time
   

The rendering process may take several minutes or even hours to complete. The following table
describes the factors that affect rendering.

 
  
Factor

  
Description

  Model complexity   A large and complex building model with complicated surfaces and
reflective materials takes longer to render than a simple model. For
example, an exterior view of a multitower glass skyscraper takes longer
than an exterior view of a small brick house.

  Image size   A large image takes longer to render. For example, if a camera view is set
to 1,024 x 768 pixels, an image will take longer to render than an image of
640 x 480 pixels.

  Image resolution   A high value of dots per inch (DPI) results in longer rendering process
time. For example, if you use Medium or High options from the Settings
list, the image takes longer to render.

  Lights   The rendering process time decreases if you turn on only the lights
required for a view. For example, for daytime exterior renderings, you can
render only with the sun turned on and all artificial lights turned off.
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Example of Rendering
  

The following illustrations show rendered images of the exterior and interior areas of a building model. 

 An exterior scene in which the time of the day is set for low-angle shadows. Landscaping and
entourage components cast shadows on the facade. Sky and clouds form the background behind other
landscaping elements, and the toposurface divides into concrete and grass.

   

 An interior scene lit by suspended ceiling light fixtures and wall sconces. Notice that the glass looks
transparent, shiny surfaces reflect, and solid objects cast shadows.
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Settings for Creating Renderings
   

You can specify various settings when you render a building model. The values of the settings
determine the final appearance and quality of the rendered image. You can specify quality, output,
lighting, background, image, display, and sun and shadow settings for a rendering. You can also specify
materials or texture settings for the model elements. To specify these settings, you use the Rendering
and Materials dialog boxes.

 
Rendering Settings

  
You specify rendering settings using the Rendering dialog box. The Rendering dialog box contains
various controls for rendering 3D views. It provides customized values that help you generate high-
quality rendered images easily without having an in-depth understanding of the rendering process.
You access the Rendering dialog box by selecting the Show Rendering Dialog on the View Control Bar.
The Show Rendering Dialog option is present only in 3D views.  

 Rendering dialog box
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The following table describes various settings that you can specify in the Rendering dialog box.

 
  
Setting

  
Description

  Render   Starts the raytracing process to generate the rendered image. You can
specify a render region to generate a partial rendering of the building
model by selecting the Region check box. Partial rendering helps you check
colors and materials prior to the final rendering.

  Quality   Determines the time taken by the rendering process. You can use the Draft
or Low options from the Settings list to quickly generate rendered images
without many details. The Medium or High options generate images with
more details but take longer than the fast-speed options.

  Output Settings   Specifies the output medium, such as screen or printer. You can specify
resolution settings to control the output by selecting the Printer option.

  Lighting   Specifies interior or exterior lighting or a combination of natural and
artificial light. You can specify sun settings for specific angles or by global
location. You can also group interior lights to control lighting efficiently.

  Background   Specifies a sky background with varying amounts of cloud or a single color.
You can also specify haze effects.

  Image   Adjusts the image exposure or brightness after the rendering is created.
You can also specify settings to save the rendered image as a view inside a
project or export it to an external file.

  Display   Shows or hides the rendering so that you can adjust the model or view.
  
 

Sun and Shadows Settings
  

The Sun and Shadows Settings dialog box helps you control the sun angle for renderings and solar
studies. You access this dialog box from the Rendering dialog box. You can create different sun and
shadow settings by varying the values for place, time, and date. You can also rename or delete these
settings, as required.  
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Materials Dialog Box

  
You can control the appearance of building components in rendered views by setting the properties
of the materials in the Materials dialog box. A large number of render textures are available in the
software library that you can assign to materials. The render textures help you generate a realistic
image.

  
You access the Materials dialog box from the Project Settings panel of the Manage tab.  

 Materials dialog box
   

The Render Appearance tab in the Materials dialog box lets you set the render appearance of any
material in a project file. You can adjust the reflectivity and transparency of materials using the
Materials dialog box. The Replace option opens the Render Appearance Library dialog box in which
you assign render textures to the materials from the render appearance library.
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Guidelines for Creating Renderings
   

The following recommended practices help you create rendered images successfully.
 

Guidelines
■ Use the Region option to test materials, lighting, and exposure settings when you first set up

a rendered view. You can use the Region option to check the rendering for a region before you
render the complete image.

■ Use the Draft setting for the first few renderings of a 3D view to save time. Once the 3D view is set
up, you can use a slow-speed, high-quality option.

■ Adjust the final position and orientation of rendering components, such as the camera location,
clouds, materials, humans, landscaping, and entourage, as you start the rendering process.
When you are satisfied with the composition of your image and the effects such as shadows and
reflections, you can pin items in place for the final rendering. 

 
Example

  
The following illustration is an example of how a region of a building model is rendered to test
materials, lighting, and exposure settings before you render the complete building. 
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Lesson: Using Walkthroughs
 

  
This lesson describes how to create and export a walkthrough of a building model. You begin the
lesson by learning about walkthroughs. Then, you learn about some recommended practices for using
walkthroughs. The lesson concludes with an exercise on creating and exporting a walkthrough.  
Walkthroughs allow you to show your building model to clients or regulators in an animated form
that can be played in any media player. You create a walkthrough to view the interior or exterior of a
building model as a movie.  

 Walkthrough image
 
 

Objectives
  

After completing this lesson, you will be able to:

■ Describe walkthroughs.
■ State the recommended practices for using walkthroughs.
■ Create and export a walkthrough.
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About Walkthroughs
   

You use a walkthrough to view your building model by means of a camera placed at strategic angles in
and around the building model. You create a walkthrough by placing the camera on a path that forms
an animated sequence of views of a building model.

 
Definition of Walkthroughs

  
A walkthrough is a collection of camera views or frames placed in a sequence. You create a
walkthrough in your project by placing keyframes to generate a camera path in a plan view. You then
adjust view properties, such as position, direction, and field of the camera, for different keyframes, as
required. You can adjust the properties of all the keyframes that are a part of the walkthrough in the
Instance Properties dialog box.

 
Keyframes

  
A keyframe is a modifiable frame in a walkthrough. You can manage the direction and position
of the camera at a keyframe. The properties of all the frames between two keyframes are linked.
Therefore, you do not have to adjust the camera at frames in between the keyframes, Revit does this
automatically.

  
If you adjust the camera differently at two keyframes, the software minimizes the difference between
the keyframes. This ensures smooth transition between keyframes in the walkthrough.

  
You can open the camera view at any frame and play the walkthrough in the project file.

 
Camera and Path

  
You create a walkthrough by placing the keyframes of a camera along a path in a plan view. Revit uses
a spline to connect the keyframes that you place while drawing the path. Once you have finished
drawing a path, you can edit it by moving, adding, or deleting keyframes.

  
When you place a camera at a keyframe, you can set the camera to perspective view or orthographic
view. You can also set the level and height offset for the camera location. By default, the camera is set
to average eye height above the given level.

  
You can change the camera angle and depth of field of a view after the walkthrough path is defined.
To do this, you open the view for a keyframe in a walkthrough and change the field of a view. Use
Steering Wheels to alter the camera placement and direction.  
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 Walkthrough path and the field of view for a camera
  
 

Example of Walkthroughs
  

The following illustrations show a walkthrough in the plan and camera views. In the plan view, the
triangle represents the field of a camera view and the red dots represent the keyframes on the
walkthrough path. The camera view shows a keyframe of the walkthrough. 

 Walkthrough in a plan view
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 Walkthrough in a camera view
 
 

Guidelines for Using Walkthroughs
   

Walkthroughs present the building model in the form of a movie that can be played without using
Revit. The following recommended practices help you use walkthroughs effectively.

 
Guidelines
■ Create a walkthrough that examines or illustrates a particular area of the building model from

more than one point of view. You can use such a walkthrough to describe the problem areas of the
building model in more detail instead of using a walkthrough that examines the building model
from a single point of view covering interior hallways.

■ Minimize side-to-side movement of the camera while creating a walkthrough. For example, if you
swing the camera from left to right quickly, the viewer will not be able to see what you are trying
to illustrate. Also, jerky camera movements can make some viewers uncomfortable.

■ Place a circular walkthrough with the camera focusing inward in your project template file if a
certain size is specified for a building project. This way, as soon as you create the building model,
you can study its exterior in the walkthrough and send the walkthrough to your client for review.
This reduces the time taken in the review cycle.

■ Place the walkthrough camera away from the model rather than close. This results in more realistic
perspective angles in the camera view.

■ Adjust the depth of the field control to ensure that all the important parts of the building model,
such as walls in the background of a view, are visible. This saves time on adjustments later in the
design process.

■ Experiment with camera placement and angle. For example, if you place keyframes together, the
movement of keyframes along the path slows down and you can adjust the camera angle to look
up and down a facade. This makes the walkthrough an effective analysis and display tool.

■ Adjust the playing speed of the walkthrough. Playing speed refers to the number of frames per
second. Adjusting the playing speed controls the display quality when you create the export file.

■ Use the Hidden Line display while setting up the walkthrough and change to Shading with Edges
or Rendering for the final export. Shaded or rendered files take longer to generate. Therefore, plan
your workflow accordingly. You can save time by not using time-consuming procedures until views
and settings are correct. 
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Example
  

The following illustration shows a circular walkthrough with the camera focusing inward. Using this
walkthrough, you can study the building exterior and send the walkthrough to your client for review,
reducing the review cycle. 
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Lesson: Using Sun and Shadow Settings
 

  
This lesson describes how to use sun and shadow settings in a building model. You begin the lesson by
learning about sun and shadow settings and some recommended practices for using these settings.
The lesson concludes with an exercise on using sun and shadow settings to create shadows of a
building model.  
Sun and shadow settings help you analyze sun positions and solar effects on a building model. You can
use the analysis to plan the placement of a building model and its surrounding components, such as
playgrounds and lighting fixtures.    
The following illustration shows a building model in a plan view with sun and shadow settings applied
at two different angles. Notice that southeast is appropriate for a winter morning in the northern
hemisphere.

 

    Sun from the southeast direction   Sun from the northeast direction
  
 

Objectives
  

After completing this lesson, you will be able to:

■ Describe sun and shadow settings.
■ State the recommended practices for using sun and shadow settings.
■ Use sun and shadow settings to create shadows of a building model.
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Sun and Shadow Settings
   

The application of sun and shadow settings to the building model helps in the presentation and
evaluation of a building design. You can view the effects of sun and shadows for a building model and
its components in plan, elevation, section, and 3D views as a solar study in the form of frames. You
can also export the solar study as snapshots in the form of an AVI file.

  
You apply sun and shadow settings by using the Graphic Display Options and the Sun and Shadows
Settings dialog boxes. In the Graphic Display Options dialog box, you specify the direction of the sun,
the intensity of sunlight and shadows, and a line style for silhouette edges. When you use the Sun and
Shadows Settings dialog box, you can either use the default sun and shadow settings or create custom
settings for a building model.

  
Using both the dialog boxes, you can apply sun and shadow settings to a view in any model graphics
style except Wireframe. If there is no site object visible in a view, you can specify a ground plane on
which the shadow will display.   
The following illustration shows the direction of the sun and the resultant shadow cast by a building
model in a 3D view. 
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Silhouette Edges

  
A silhouette style determines the display of the silhouette edges of walls and wall components, such
as doors and windows. You use the Silhouette Style list in the Graphic Display Options dialog box to set
a line style for silhouette edges. This dialog box can be accessed by selecting Graphic Display Options
from the Shadows On/Off list on the View Control Bar. You can override a silhouette style to highlight
the building edges even if shadows are applied to the entire building model.  

  
  Silhouette Style set to <None>   Silhouette Style set to Wide Lines

   
 

Sun and Shadows Settings Dialog Box
  

You access the Sun and Shadows Settings dialog box by clicking […] in the Graphic Display Options
dialog box. 

    
The following table describes the tabs in the Sun and Shadows Settings dialog box.

 
  
Tab

  
Description

  Still   Specifies the effects of the sun and shadows on a building model for a
particular date, time, and place. You can also specify the effects of the sun
and shadows for a particular azimuth and altitude of the sun.

  Single-Day   Specifies the effects of the sun and shadows on a building model for one
complete day between specified time intervals.

  Multi-Day   Specifies the effects of the sun and shadows on a building model between
specified dates and time intervals.
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Guidelines for Using Sun and Shadow Settings
   

The following recommended practices help you to use sun and shadow settings effectively.
 

Guidelines
■ Create multiple sun and shadow settings that show shadows at equinox and solstice days or at

morning, noon, and late afternoon. This helps you create a ready reference for sun and shadow
settings that can be loaded into a project template. These settings are valuable in designing
window locations and roof overhangs, which can have a significant impact on building energy
profiles.

■ Avoid using views for late afternoons and early mornings for presentations because during
these times of the day, the sun casts dramatic and long shadows, which can completely darken a
building facade. To represent long shadows, set the shadow intensity to a low value.

■ Create an in-place family to represent trees for shadow studies because in Revit, landscaping
objects and plantings do not cast shadows in plan views. Creating an in-place family is helpful
when the shadows cast by large trees are an important factor in the design of a building. 

 

Example
   

The following illustrations show how shadows are cast on a building model when custom settings are
specified in the Sun and Shadows Settings dialog box. This setting enables you to avoid the darkening
of a building facade.

 

 

   Sun and Shadows Settings dialog box with
custom settings

  Building model with long shadows at low intensity
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